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USER’S NOTICE

Product Name: ASUS PCI-DA2100
Manual Revision: 1.23
Release Date: October 1997

No part of this manual, including the products and software described in it, may be repro-
duced, transmitted, transcribed, stored in a retrieval system, or translated into any language in
any form or by any means, except documentation kept by the purchaser for backup purposes,
without the express written permission of ASUSTeK COMPUTER INC. (“ASUS”).

ASUS PROVIDES THIS MANUAL “AS IS” WITHOUT WARRANTY OF ANY KIND, EI-
THER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OR CONDITIONS OF MERCHANTABILITY OR FITNESS FOR A PAR-
TICULAR PURPOSE. IN NO EVENT SHALL ASUS, ITS DIRECTORS, OFFICERS, EM-
PLOYEES OR AGENTS BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF PROFITS, LOSS
OF BUSINESS, LOSS OF USE OR DATA, INTERRUPTION OF BUSINESS AND THE
LIKE), EVEN IF ASUS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAM-
AGES ARISING FROM ANY DEFECT OR ERROR IN THIS MANUAL OR PRODUCT.

Product warranty or service shall not be extended if: (1) the product is repaired, modified or
altered, unless such repair, modification of alteration is authorized in writing by ASUS; or (2)
the serial number of the product is defaced or missing.

Products and corporate names appearing in this manual may or may not be registered trade-
marks or copyrights of their respective companies, and are used only for identification or
explanation and to the owners’ benefit, without intent to infringe.

• Intel, LANDesk, and Pentium are registered trademarks of Intel Corporation.
• IBM and OS/2 are registered trademarks of International Business Machines.
• Symbios is a registered trademark of Symbios Logic Corporation.
• Windows and MS-DOS are registered trademarks of Microsoft Corporation.
• Sound Blaster AWE32 and SB16 are trademarks of Creative Technology Ltd.
• Adobe and Acrobat are registered trademarks of Adobe Systems Incorporated.

The product name and revision number are both printed on the product itself. Manual revi-
sions are released for each product design represented by the digit before and after the period
of the manual revision number. Manual updates are represented by the third digit in the manual
revision number.

For previous or updated manuals, BIOS, drivers, or product release information, contact ASUS
at http://www.asus.com.tw or through any of the means indicated on the following page.

SPECIFICATIONS AND INFORMATION CONTAINED IN THIS MANUAL ARE FUR-
NISHED FOR INFORMATIONAL USE ONLY, AND ARE SUBJECT TO CHANGE AT
ANY TIME WITHOUT NOTICE, AND SHOULD NOT BE CONSTRUED AS A COM-
MITMENT BY ASUS. ASUS ASSUMES NO RESPONSIBILITY OR LIABILITY FOR
ANY ERRORS OR INACCURACIES THAT MAY APPEAR IN THIS MANUAL, INCLUD-
ING THE PRODUCTS AND SOFTWARE DESCRIBED IN IT.

Copyright © 1997 ASUSTeK COMPUTER INC. All Rights Reserved.
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ASUS CONTACT INFORMATION
ASUSTeK COMPUTER INC.
Marketing Info
Address: 150 Li-Te Road, Peitou, Taipei, Taiwan 112, ROC
Telephone: +886-2-894-3447
Fax: +886-2-894-3449
Email: info@asus.com.tw

Technical Support
Fax: +886-2-895-9254
BBS: +886-2-896-4667
Email: tsd@asus.com.tw
WWW: www.asus.com.tw
Gopher: gopher.asus.com.tw
FTP: ftp.asus.com.tw/pub/ASUS

ASUS COMPUTER INTERNATIONAL
Marketing Info
Address: 721 Charcot Avenue, San Jose, CA 95131, USA
Telephone: +1-408-474-0567
Fax: +1-408-474-0568
Email: info-usa@asus.com.tw

Technical Support
BBS: +1-408-474-0569
Email: tsd-usa@asus.com.tw
WWW: www.asus.com

ASUS COMPUTER GmbH
Marketing Info
Address: Harkort Str. 25, 40880 Ratingen, BRD, Germany
Telephone: 49-2102-445011
Fax: 49-2102-442066
Email: info-ger@asus.com.tw

Technical Support
BBS: 49-2102-448690
Email: tsd-ger@asus.com.tw
Hotline: 49-2102-499712
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FCC & DOC COMPLIANCE
Federal Communications Commission Statement
This device complies with FCC Rules Part 15. Operation is subject to the following
two conditions:

• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that

may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installa-
tion. This equipment generates, uses and can radiate radio frequency energy and, if
not installed and used in accordance with manufacturer’s instructions, may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interfer-
ence by one or more of the following measures:

• Re-orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment to an outlet on a circuit different from that to which the

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING!   The use of shielded cables for connection of the monitor to the
graphics card is required to assure compliance with FCC regulations.  Changes
or modifications to this unit not expressly approved by the party responsible for
compliance could void the user’s authority to operate this equipment.

Canadian Department of Communications Statement
This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.
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I. INTRODUCTION
ASUS PCI-DA2100 RAID Controller
The ASUS PCI-DA2100 is a PCI-to-SCSI RAID controller specifically designed to
provide RAID 0, 1, 3 or 5 capability to any host system equipped with Little Endian
PCI Local Bus interface. (For a description of RAID, see I. RAID Management
under Part IV: Appendices.) All the RAID functions of ASUS PCI-DA2100 are per-
formed by a 486 CPU coupled with high-speed DRAMs and firmware in Flash
Memory. In effect, it endows the host system with the high performance and fault-
tolerant disk storage operation of RAID technology. It is also an ideal solution for
weaving several hard disks into one contiguous volume.

The ASUS PCI-DA2100 has a comprehensive drive failure management that allows
automatic bad block reassignment when a bad sector is encountered during a write.
Hot-swapping is supported through automatic detection of failed drives, followed
by either automatic background rebuilding onto a spare if a spare is assigned or
manual replacement of failed drive and manually initiated background rebuilding.
All these failure recovery operations are performed in a way transparent to the host.

The controller has been designed with the ease of integration and maintenance in
mind. The major features are described in the following section. The ASUS PCI-
DA2100 already includes all the major operational requirements for a RAID sub-
system. The final features of a fully-built RAID subsystem will, however, depend
on the actual components used and the creativity of the integrator.

I. 
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Features of the ASUS PCI-DA2100
• Five operating modes:

Non-RAID Disk Spanning (including JBOD)

RAID-0 Striping

RAID-1 Mirroring and Striping (RAID 0+1)

RAID-3 Block Striping with Dedicated Parity

RAID-5 Multiple Block Striping with Distributed Parity

• Comprehensive failure management including:

Automatic bad sector reassignment

Hot-swapping

Spare drive operation (Global Spare and Local Spare support)

Background rebuilding (rebuild priority selectable)

• PCI Rev. 2.1 compliance

• PCI Standard length form factor: 17.5 (L) x 10.7 cm (W) (6.87" x 4.2").

• Up to 15 SCSI IDs per channel.

• Up to 8 logical drives, each with independent RAID modes.

• Up to 8 partitions per logical drive.

• Logical drive can be assigned a name for ease of identification.

• Unlimited drive quantities for each logical drive.

• Dynamic mapping of LUNs to logical drives. Two or more LUNs can be mapped
to the same logical drive for redundant host operation.

• Concurrent/Background logical drive initialization.

• Performance optimization for Sequential or Random I/O.

• Allows multiple drive failure in RAID 1 and concurrent multiple drive rebuild
for multiple-drive failed RAID 1 logical drives.

• Configuration of individual SCSI target parameters.

• Controller can be assigned a name for ease of identification.

II. FEATURES

II. FEATURES
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II. FEATURES

II.
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• Allows adjustment of delay prior to first disk access during controller initializa-
tion to enhance compatibility with slow-initial drives.

• All channels are Ultra Wide SCSI-2 (downward compatible to SCSI-1) and can
be configured as either host or drive interface.

• Compatibility and automatic matching of any SCSI hard disks complying with
SCSI-1, SCSI-2, or (Ultra)-Wide-SCSI (1 or 2) specifications.

• Full Ultra Wide SCSI-2 implementation including Tagged Command Queuing
and Multi-Threaded I/O.

• Uses 486 CPU with all executable firmware downloaded into high-speed DRAM.

• BIOS INT 13 support.

• EDO RAM support for enhanced performance.

• Up to 64 MB of intelligent Read-Ahead/Write-Back cache with backup battery
option.

• Flash Memory for easy firmware and BIOS updates.

• Easy-to-use Text  or GUI RAID Manager for RAID management.
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III. INSTALLATION
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Pin Descriptions
1 +5V
2 GND
3 GND
4 +5V

PIN 1

JP6

JP1, JP2, JP5, JP7: Factory use. Open for normal operation.

JP6: LED Connector for hard disk drive activity light.

JP13: Connector for manufacturing diagnostic.

ASUS PCI-DA2100 RAID Controller

Fast & Wide SCSI Ch.0 Fast & Wide SCSI Ch.1

SIMM Socket for
Cache Upgrade

486 Processor

Non-Volatile SRAM
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Installing DRAM SIMM

IMPORTANT:  The ASUS PCI-DA2100 requires a minimum of 4MB of DRAM
in one SIMM (with or without parity function) installed in SIMM socket to
operate. The controller is normally delivered without any DRAM installed.

Guidelines
• Use 72-pin 60 ns DRAM or 60 ns EDO RAM SIMM module. EDO RAM is

recommended to improve performance.

• DRAM with or without parity is autodetected by ASUS PCI-DA2100, but DRAM
with parity is recommended for security.

• Minimum DRAM required is 4 MB installed in SIMM socket. 8MB is, how-
ever, recommended.

• ASUS PCI-DA2100 supports 4MB, 8MB, 16MB, 32MB, 64MB DRAM SIMM
module. Maximum DRAM size is 64 MB.

Installation

1 Power off the system and disconnect the power connector.

2 Insert the DRAM SIMM paralleled with the key to the left (1). Then, push to-
ward the back until the hooks on both sides of the socket snap into place (2).

III. INSTALLATION
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III. INSTALLATION

III. INSTALLATIO
N

Basic Setup

Basic Operational Set-up

Sample Operational Set-up

SCSI Cable

SCSI Cable

ASUS PCI-DA2100
RAID Controller

Terminator

Terminator
• • • • •

• • • • •

Up to
15 Drives

Up to
15 Drives

To connect the components:

• Make sure the system power has turned off and the power connector is discon-
nected.

• Install the ASUS PCI-DA2101 RAID controller in a vacant PCI slot.

• Plug one end of the drive SCSI cable to one of the drive channel on the controller.

• Connect the hard disk(s) to the drive SCSI cable.

• Total length of SCSI cable must not be more than 1.5 meters.

• Drives connected to channel 0 and/or channel 1.

• SCSI nodes on the same channel have unique ID number. SCSI ID 7 is reserved
for the ASUS PCI-DA2100 adapter and thus no drives should use ID 7.

• Both ends of all SCSI cables are properly terminated. The external channel 0
and internal channel are the same channel — the total devices on external and
internal channel 0 should not exceed 15.

• Enable the termination of channel 0 if no external devices connected.

• Disable the termination of channel 0 if external devices are connected.

• Enable the termination of channel 1.
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III. INSTALLATION
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• Terminate the SCSI cable by either installing a terminator on the
farthest hard disk from the controller or by installing an external
terminator on the end connector. Installing an external terminator on the end
connector is, however, preferred because removal of the hard disk will not
affect cable termination. All other terminators must be removed making sure
that only one terminator is installed.

• Power supply attached to all the devices.

• All operation parameters properly set.

• The default state of terminators embedded on the ASUS PCI-DA2100 controller
are enabled, which can be changed by running the Text RAID Manager
(RAIDMAN.EXE).

External
Channel 0

SCSI Cable

SCSI Cable

ASUS PCI-DA2100
RAID Controller

Terminator

Terminator
• • • • •

• • • • •

Up to
15 Drives

Up to
15 Drives

Terminator
Disabled

Terminator
Enabled

Internal and External Channel 0 Up to 15 Drives

TerminatorSCSI Cable

Internal
Channel 0

Internal
Channel 1

The external channel 0 and internal channel are the same channel — the total de-
vices on external and internal channel 0 should not exceed 15. Disable the termina-
tion of channel 0 if external devices are connected.

External
Channel 0

SCSI Cable

SCSI Cable

ASUS PCI-DA2100
RAID Controller

Terminator

Terminator
• • • • •

• • • • •

Up to
15 Drives

Up to
15 Drives

Terminator
Enabled

Terminator
Enabled

Internal
Channel 0

Internal
Channel 1

Enable the termination of channel 0 if no external devices are connected.
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IV. BIOS SOFTWARE

BIOS Configuration Utility

At system bootup, the ASUS PCI-DA2100 BIOS displays a message similar to the
following:

ASUS PCI-DA2101 (PCI-TO-SCSI RAID) BIOS v1.14A
PCI Bus # = 00 Device # = 0C Port = D400 IRQ = 12 EDORAM=8 MB FW=1.22X
!! Press <Ctrl><I> for Configuration Utility, <Q> to Skip !!

NOTE:  ASUS PCI-DA2100 BIOS waits 3 seconds for a keystroke. You can press
[Ctrl-I]  to enter the configuration utility, or press Q to skip waiting for a keystroke.

If [Ctrl-I]  is pressed to enter configuration utility, the main menu will appear.
There are two functions in the main menu: Configuration and Color/Monochrome.

PCI Bus #  /  Device #
Show the PCI bus and PCI device number assigned to your ASUS PCI-DA2100.
The numbers are in hexadecimal.

Port
Shows the I/O port base address assigned to your ASUS PCI-DA2100.

IRQ
Shows the Interrupt level, in decimal, assigned to your ASUS PCI-DA2100.

EDO RAM DRAM
Displays the cache RAM type and size installed on your ASUS PCI-DA2100.

FW
Shows the firmware version of your ASUS PCI-DA2100.
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Configuration

Four options are available under the Configuration  menu: Configure BIOS, Con-
figure Card, Configure SCSI, and Reset to Defaults.

Configuration     Color/Monochrome

 Configure Card

 Configure SCSI

 Reset to Defaults

 Configure BIOS

Configure BIOS

Enable BIOS INT 13H Function Yes
BIOS Translation Mode Auto
Support for Disks > 1 GB Yes
Support for 3 Disks or More (MS-DOS v5.0 or above) Yes
Support for NOT-ZERO SCSI LUN Yes
Configure BIOS Devices <Enter>

Enable BIOS INT 13H Function
Press [Space] to toggle between Yes or No.

BIOS Translation Mode
Press [Space] to toggle between Auto and Fixed. Use fixed mode together with
disabling “Support for Disks > 1GB”  for UNIX/DOS or UNIX/OS2 dual boot sys-
tem. Use Auto mode for other operating systems.

Auto mode
• BIOS detects the existing CHS mapping from the disk.
• If any valid CHS mapping is found, BIOS uses it.
• If no valid CHS mapping is found, BIOS uses Fixed mode.

Fixed mode
• If option “Support for Disks > 1 GB” is disabled,

BIOS uses SectorsPerTrack = 32, TotalHeads = 64.

• If option “Support for Disks > 1 GB” is enabled,
For disk size ≤ 1GB, BIOS uses SectorsPerTrack = 32, TotalHeads = 64.
For disk size > 1GB, BIOS uses SectorsPerTrack = 63, TotalHeads = 255.

IV. BIOS SOFTWARE
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Support for Disks > 1 GB
Press [Space] to toggle between Yes or No.

Support for 3 Disks or More (MS-DOS v5.0 or above)
Don’t set this option to “Yes” for MS-DOS versions earlier than 5.0, which only
supports up to 2 disks.

Support for NOT-ZERO SCSI LUN
Set this option to “Yes”, if you want the BIOS to support all SCSI Target LUNs, 0 to 7.

Configure BIOS Devices

Logical Device SCSI ID     #0  #1  #2  #3  #4  #5  #6  #7
Scanned By BIOS            Yes Yes Yes Yes Yes Yes Yes Yes

Logical Device SCSI ID     #8  #9  #10 #11 #12 #13 #14 #15
Scanned By BIOS            Yes Yes Yes Yes Yes Yes Yes Yes

If this option is selected, a status list of SCSI device scanned by BIOS at BIOS
initialization will appear. If a SCSI device is not scanned by BIOS, then it will not be
installed by BIOS.

Configure Card

ISA Emulation Mode IO Port Address    Disabled
Disk Access Delay on Power-up (Sec)   15

You can select an IO Port address by pressing [Enter] .

NOTE:  If you want to use the device driver provided by ASUS, you MUST set
the I/O port address to Disabled.

IV. BIOS SOFTWARE
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Configure SCSI

Configuration     Color/Monochrome

 Configure BIOS

 Configure Card

 Configure SCSI

 Reset to Defaults

 SCSI Channel 0

 SCSI Channel 1

SCSI Channel 0

If this option is selected, a list of physical SCSI channels will appear.

Select a SCSI channel that you want to configure, then a new dialog box of SCSI
Channel Configuration will appear.

SCSI Channel 0 Configuration :
SCSI ID                         7
Enable SCSI Termination         Yes
Configuration SCSI Devices      <ENTER>
Enable Wide SCSI                Yes

SCSI ID
Use this option to change SCSI ID of SCSI Channel.

Enable SCSI Termination
Use this option to enable/disable SCSI termination.

Configure SCSI Devices
Use this option to change the low-level SCSI features of SCSI devices.

Device SCSI ID             #0  #1  #2  #3  #4  #5  #6  #7
Sync Transfer Period (4ns) 12  12  12  12  12  12  12  12
Enable SCSI Disconnect     Yes Yes Yes Yes Yes Yes Yes Yes
Enable SCSI Parity         Yes Yes Yes Yes Yes Yes Yes Yes
Enable Wide SCSI           Yes Yes Yes Yes Yes Yes Yes Yes

Device SCSI ID             #8  #9  #10 #11 #12 #13 #14 #15
Sync Transfer Period (4ns) 12  12  12  12  12  12  12  12
Enable SCSI Disconnect     Yes Yes Yes Yes Yes Yes Yes Yes
Enable SCSI Parity         Yes Yes Yes Yes Yes Yes Yes Yes
Enable Wide SCSI           Yes Yes Yes Yes Yes Yes Yes Yes

IV. BIOS SOFTWARE
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Refer to Synchronous Transfer Period under V. Appendices of Part I: Hardware
Installation  to calculate the transfer clock rate for the transfer period calculation.

Enable Wide SCSI
Use this to enable/disable wide SCSI.

Reset to Defaults
If this option is selected, all the configurations are reset to the factory defaults.

Color/Monochrome

Switches display mode of the utility software between color and monochrome.

IV. BIOS SOFTWARE

IV. BIO
S

C
onfigure C

ard



ASUS PCI-DA2100 User’s Manual 21

V.
 A

PP
EN

DI
CE

S
Sp

ec
ifi

ca
tio

ns

V. APPENDICES

Specifications

RAID level 0, 1, 3, 5 (or non-RAID disk spanning)
Operation Firmware on Flash Memory and DRAM

running on 486 CPU
Failure management Bad sector reassignment, hot-swapping,

hot spare drive operation, background
rebuilding

Failure indicator Via Text RAID Manager,
GUI RAID Manager and onboard buzzer

Cache size Up to 64 MB
Host interface PCI Rev. 2.0
Hard disk interface Ultra Wide SCSI 2
Hard disk channels Up to 2
Channel Terminator Active, software programmable
SCSI protocol SCSI-1, SCSI-2, Fast Wide SCSI-1 or

Fast Wide SCSI-2 (auto-match),
Ultra-Wide SCSI-1 or Ultra-Wide SCSI-2

SCSI transfer rate 40MB/sec synchronous
10MB/sec asynchronous

Max. SCSI drives 14
No. of logical drives 8 with different RAID levels
Partitions 8 per logical drive, total of 64
No. of LUNs 8 per channel, total of 64 (dynamic mapping

to logical drives or partitions)
Control Via Text RAID Manager or

GUI RAID Manager
SCSI connectors 68-pin header for internal channels,

68- pin High-Density female connector for
external channel

SCSI cabling Single-ended
Voltage +5 Volts
Current 2 Amp
Operating Temperature 0˚ to 45˚ C
Relative Humidity 10–96%, non-condensing
Operating Altitude Sea level to 3000 m (10,000 ft)
Dimensions 17.5 cm (L)  x 10.7 cm (W)

( 6.87 in x 4.2 in)
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Updating BIOS, Firmware, and Boot Record

The BIOS, firmware and boot-record (the section of code that boots the controller
and allows for temporary download of firmware) of the ASUS PCI-DA2100 stored
in Flash Memory can be updated via Text RAID Manager under DOS. New re-
leases of the BIOS/firmware/boot-record are available on the ASUS BBS and the
Internet (see ASUS Contact Information on page 3).

To perform the download, the following must be available:
• ASUS PCI-DA2100 plugged into a host PCI slot and properly functioning.
• RAIDMAN.EXE running under DOS.

To perform the download, follow the following procedures:
1 Select “Controller Maintenance” under “System Functions” via the Text RAID

Manager.
2 Select the desired download option. If upgrading both firmware and boot-record,

select “Advanced Maintenance Functions” menu item then select “Download
Boot Record with Firmware”.

3 When the prompt for operation confirmation appears, select” Yes” to confirm.
4 When prompted for a filename, enter the name of the file containing the code to

be downloaded. If both firmware and boot-record are being downloaded, enter
the name of the boot-record file.

5 If both firmware and boot-record are being downloaded, when downloading of
boot-record is complete, repeat step 4, then, when prompted for a filename,
enter the name of firmware file.

6 When file transfer is complete, wait for a moment while the ASUS PCI-DA2100
burns the code into the EEPROM-Flash.

IMPORTANT:  Be sure to allow the EEPROM-Flash programming (burning)
stage to complete. Do not reset or turn off the computer or the controller while
EEPROM-Flash programming is in progress. Doing so may result in an unre-
coverable error that requires the service of the manufacturer.

V. APPENDICES
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SCSI-related Information

The Ultra-Wide SCSI-2 recommendation for a SCSI cable operating at a transfer
rate of 20 MB/sec is as follows:

• Maximum length 1.5 meters

• Impedance Between 90 Ω to 132 Ω

• Signal Attenuation 0.095 dB/meter @ 5 MHz (max.)

• Pair-Pair Propagation Delay Delta 0.2 ns/meter (max.)

• DC Resistance 0.23 Ω/meter @ 20˚ C (max.)

SCSI Standards, Cable Length and Corresponding
Maximum Possible Drive Connections

Single-Ended Differential Maximum
Drives

SCSI-1 6.0 m 25 m 8
SCSI-2 3.0 m 25 m 8
Wide SCSI-2 3.0 m 25 m 16
Ultra SCSI-2 1.5 m 25 m 8
Ultra SCSI-2 3.0 m – 4
Ultra Wide SCSI-2 – 25 m 16
Ultra Wide SCSI-2 1.5 m – 8
Ultra Wide SCSI-2 3.0 m – 4

SCSI Bus Width and Maximum Throughput
Bus SCSI Bus Max. Bus SCSI ID

Width Sync. Frequency Throughput Up to

SCSI-1 8-bit Asynchronous 5 MB/Sec 7
(Fast) SCSI-2 8-bit 10 Mhz 10 MB/Sec 7
(Fast) Wide SCSI-2 16-bit 10 Mhz 20 MB/Sec 15
Ultra SCSI-2 8-bit 20 Mhz 20 MB/Sec 7
Ultra Wide SCSI-2 16-bit 20 Mhz 40 MB/Sec 15
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V. APPENDICES

V. APPENDICES
Sync. Transfer

Synchronous Transfer Period

In the Text RAID Manager or in the SCSI ROM BIOS settings, when changing the
SCSI Synchronous Transfer Period of each SCSI target, it is a low-level control to
the SCSI controller chip, there is no options selectable, only the Synchronous Trans-
fer Period is available in this field.

To calculate the Synchronous Transfer Period, refer to the “Sample equation” to get
the correct Synchronous Transfer Period.

Sample equation:

Mhz
ns

nsMhz

8.2 0
1 041 2

1
41 2

1

1 2
1 041 08.2 0

1
48.2 0

1

9

96

=
××

=
×

=
×××

=
×

−

−

In this example, where “20.8Mhz” is called the Synchronous Clock Frequency, “12”
is called the Synchronous Transfer Period.

Synchronous Synchronous Synchronous Synchronous
Transfer Period Clock Frequency Transfer Period Clock Frequency

12 20.8 62 4.0

15 16.6 75 3.3

18 13.8 88 2.8

25 10.0 100 2.5

31 8.0 110 2.2

37 6.7 120 2.0

43 5.8 135 1.8

50 5.0 0 Asynchronous
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Check

1. PCI slot contact quality.
2. Minimum of 4MB DRAM SIMM installed.

1. ID numbers (must be unique for each
device on the same SCSI channel).

2. Terminators are properly installed.
3. Check the voltage output of the power supply.

1. ID numbers (must be unique for each
device on the same SCSI channel).

2. Terminators are properly installed.

1. Drive power connections.
2. Drive SCSI cable connections.
3. ID numbers (must be unique for each

device on the same SCSI channel).

1. This error does not indicate that the
controller cannot detect the hard disks.

2. Has the logical drive been created?
3. Has the logical drive been mapped to a

SCSI ID?

1. SCSI port to LUN assignment.
2. Logical drive mapping to LUN.

1. DRAM SIMM should be replaced.

1. Proper installation or connection of one or
more of the drives (use View And Edit SCSI
Drives to help locate the problem).

Problem

7-segment is off or not flashing

SCSI channel failure detected
upon start-up with SCSI cables
connected
Buzzer continuously beeps

Initialization failure

Cannot detect SCSI drive

BIOS displays “No Disk
Installed by BIOS!”

BIOS shows no drive
connection

Parity error detected

Logical drive failure detected
during boot-up
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Troubleshooting

This section is a checklist of problems commonly encountered during installation.
For failures that occur during operation, refer to the section on “Disk Failure Man-
agement.”
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Check

1. SCSI cable must be shorter than 3 meters.
2. Terminators are properly installed.
3. Power supply voltage is within the

specifications.
4. Enclosure inner temperature.

1. See Scan New SCSI Drives under II. Text
RAID Manager of Part II: Management
Utilities .

1. The “Optimization for... I/O” in the
Caching Parameters (under View And Edit
Configuration Parameters) when creating
the logical drive is different from the
current setting.

2. Change the “Optimization for... I/O” to the
opposite setting and reset the controller.

1. The “20.8MHz” is SCSI sync frequency,
not transfer rate.

2. See SCSI-related Information under V.
Appendices of Part I: Hardware
Installation .

Problem

System is not stable after
running a period of time

When using Scan New SCSI
Drive, if the desired ID is
empty, an empty drive entry
appears.

The logical drive states “IN-
VALID”

In View And Edit SCSI Logical
Drives or View And Edit SCSI
Channels, the spped states
“20.8MHz”, not “40MHz”

V. APPENDICES

V. APPENDICES
Troubleshooting
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I.  INTRODUCTION
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0About this Section

This section of the manual describes the installation and use of the mangement utili-
ties for the ASUS PCI-DA2100, which is the product model name for the PCI-to-
SCSI RAID controller from ASUS.

ASUS provides two easy-to-use interfaces to control and manage your disk array
systems incorporating the ASUS PCI-DA2100.

Overview

• Text RAID Manager
Provides information about the Text RAID Manager menu-driven sys-
tem, installation, basic operations, array management, and terminal
operation command summary.

• GUI RAID Manager
Provides information about the GUI RAID Manager, installation, basic
operations, array management, notification configuration, demo mode,
command summary, and troubleshooting.
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II. TEXT RAID MANAGER

II. TEXT RAID MANAGER
Starting

The Main Menu will now be displayed.

Introduction

The Text RAID Manager utility, RAIDMAN.EXE, provides a user-friendly menu-
driven system for configuring and managing the ASUS PCI-DA2100 RAID Con-
troller. RAIDMAN.EXE can be run under DOS, NetWare, Windows 95, and Win-
dows NT.

NOTE:  Depending on your system configuration, the screen displays on this
manual may be different from your system.

Starting the Text RAID Manager

On execution of RAIDMAN.EXE under DOS, the screen will display a list of target
controllers. Use the ↑↓ keys to position the cursor over the desired controller and
press [Enter]  to select it.

NOTE:  The RS-232 Interface selection requires an RS-232 port. Thus this se-
lection cannot be used on the ASUS PCI-DA2100, which does not have an RS-
232 port on board.



ASUS PCI-DA2100 User’s Manual 31

II. TEXT RAID MANAGER

II. T
EX

T R
AID

 M
AN

AG
ER

Ke
ys

 U
se

d

The keys used in the Text RAID Manager are as follows:

<ARROW KEY> Left ←, right →, up ↑ and down ↓ arrow keys to select options.

[Enter] To go into a submenu or to execute an option.

[Esc] To exit or escape and go back to the preceding menu.

[F2] To toggle display color.

[Ctrl-l] To refresh terminal screen.

NOTE: If the password feature is enabled, you will be prompted to enter the
password before commands that affect configuration or operation are executed.
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II. TEXT RAID MANAGER

II. TEXT RAID MANAGER
Quick Installation

Quick Installation

New RAID System Initialization

NOTE:   A “Logical Drive” is a set of drives grouped together to operate under
a given RAID level and appears as a single contiguous drive.  The ASUS PCI-
DA2100 RAID controller is capable of grouping connected drives into as many
as 8 logical drives, each configured to the same or different RAID levels.  A
logical drive can be further divided into a maximum of 8 partitions. During
operation, the host sees an unpartitioned logical drive or a partition of a parti-
tioned logical drive as one single contiguous drive.

1 Go to Main Menu.

2 Type Q or use the ↑ ↓ keys to select “Quick Installation” and press [Enter] .

NOTE: “ Quick Installation” will (1) create a logical drive using free drives and
(2) map the logical drive to SCSI 0 LUN 0. If no free drives exist, “Logical drive
already exists!” will appear. See “Maintaining an Existing Logical Drive” for
reassignment of  current drives.
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3 Use the ↑ ↓ keys to select a RAID level and press [Enter] . (See I. Raid Manage-
ment under Part IV: Appendices for a functional description of the different
RAID levels.)

4 If a fault-tolerant RAID level has been selected, drive parity initialization will
be performed at this point.  A progress indicator similar to the one shown below
will be displayed.  When initialization is complete, the controller will automati-
cally map the entire capacity of the logical drive to SCSI ID 0 LUN 0.
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II. TEXT RAID MANAGER

II. TEXT RAID MANAGER
Logical Drives

View And Edit Logical Drives

Creating A New Logical Drive
1 Go to Main Menu.

2 Type L or use the ↑ ↓ keys to select “View And Edit Logical Drives” and press [Enter] .

3 The screen will display the current Array configuration and status.

4 Select a logical drive number which has not yet been defined by typing the
logical drive number or using the ↑ ↓ keys to select the choice and press [Enter] .
A prompt  “Create Logical Drive?” will appear.

5 To confirm creation of a new logical drive, type Y or use the ← → to select “Yes”
and press [Enter] .

6 A list of supported RAID level will appear. Chose a level by typing 5, 3, 1, 0 or
N or use the ↑ ↓ keys to select a level and press [Enter] .
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7 A list of available drive will appear. Mark (* ) the drives to be included in the
current logical drive by using the ↑ ↓ to select the drive and pressing [Enter] .

8 Press [Esc] after selecting the drives and if a fault-tolerant RAID level (1,3 or 5)
has been selected, the controller will start parity initialization. A progress indi-
cator similar to the one shown below will be displayed. When initialization has
finished, logical drive creation is complete.

9 At this point, the logical drive has been partitioned into a single
partition covering the entire drive capacity and is inaccessible to the host.

10 If different partitioning is desired, select “Partition Logical Drive”
to do the partitioning (see the subsection on “Partition Logical Drive” under the
next section, “Maintaining an Existing Logical Drive”).

11 When the Logical Drive is properly partitioned, select “View And Edit SCSI ID
Map” to map the Logical Drive Partitions to LUNs (see the section on “View
And Edit SCSI ID Map”).
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II. TEXT RAID MANAGER

II. TEXT RAID MANAGER
Logical Drives

Maintaining an Existing Logical Drive
In step 4 of the“Creating A New Logical Drive” section, if you select an existing
logical drive, then the following menu will appear on the screen:

View SCSI Drives
1 Type V or use the ↑ ↓ keys to select “View SCSI Drives” and press [Enter] .

2 The screen will display all the drives currently assigned to the logical drive as
follows:

Add Stand-By Drives
1 Type A or use the ↑ ↓ keys to select “Add Stand-by Drives” and press [Enter] .

2 A list of available drives will appear. Use the ↑ ↓ to select the drive and press
[Enter] .

3 The screen will redisplay the logical drive information indicating  a spare drive
has been assigned.

NOTE:  Drives cannot be added or removed from existing logical drives. Free
drives can only be added as “stand-by drives.” The logical drives have to be
deleted to make a drive free.
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Delete Logical Drive
1 Type D or use the ↑ ↓ keys to select “Delete Logical Drive” and press [Enter] .

2 When the following prompt appears, type Y to confirm deletion or use the ← →
to select “Yes” and press [Enter] .

WARNING!  All data on the logical drive will be lost when you confirm the
deletion.

Partition Logical Drive
1 Type P or use the ↑ ↓ keys to select “Partition Logical Drive” and press [Enter] .

2 The screen will display a partition table of up to 8 partitions with the last parti-
tion selected.  Press the [Enter]  key and type the desired size for the selected
partition followed by [Enter] .  The remaining size will be allotted to the next
partition as displayed.

 3 Repeat Step 2 for all the other partitions to be created.
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II. TEXT RAID MANAGER
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View And Edit SCSI ID Map

NOTE: Mapping a SCSI ID allows the BIOS to see the logical drive as a unique
SCSI ID.

1 Go to Main Menu.

2 Type M  or use the ↑ ↓ keys to select “View And Edit SCSI ID Map”.

3 A list of host SCSI-IDs will be displayed similar to the following:

Type or use the ↑ ↓ keys to select the SCSI ID to be mapped/unmapped and press
[Enter]
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4 A list of LUNs and their respective mapping will be displayed similar to the following:

5 To map a LUN to a Logical Drive partition, select an available LUN (one not
already mapped) and type the number of the selected LUN or use the ↑ ↓ keys to
select the desired LUN and type [Enter]

5.1 A list of available logical drives will be displayed similar to the following. Se-
lect a Logical Drive by typing the Logical Drive number or using the ↑ ↓ keys to
select the choice and press [Enter]

5.2 If the Logical Drive has been partitioned into multiple partitions, a list of parti-
tions will be displayed similar to the following:

Use the ↑ ↓ keys to select a partition number and press [Enter]

5.3 At the following prompt, type Y to confirm the mapping operation or use the
←→ keys to select “Yes” and press [Enter] .

6 To delete a host LUN mapping, use the ↑ ↓ keys to select the desired LUN and
type [Enter] .

6.1 At a prompt for confirmation similar to the following, type Y or  use ↑ ↓ keys to
select “Yes” and press [Enter] .

NOTE:  Deleting the ID map does not delete the data in the logical drive but a
new SCSI ID must be assigned for the logical disk drive to be usable.
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II. TEXT RAID MANAGER

II. TEXT RAID MANAGER
View/Edit SCSI/Spare Drives

View And Edit SCSI/Spare Drives

1 Go to Main Menu.

 2 Type D or use the ↑ ↓ keys to select “View And Edit SCSI/Spare Drives” and
press [Enter] . The screen will display all drives assigned to the logical drive.
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Scan New SCSI Drives

NOTE:  This is necessary only if a drive was not automatically detected due to a
slow start-up or insertion of drives.

1 Go to Main Menu.

2 Type N or use the ↑ ↓ keys to select “Scan New SCSI Drives” and press [Enter] .

3 Use the ↑ ↓ keys to select the SCSI channel where the new drive is installed and
press [Enter] .

4 Use the ↑ ↓ keys to select the SCSI ID number (only available IDs will be
displayed) of the new drive and press [Enter] .
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Rebuild Logical Drive

NOTE:  This step is necessary if the logical drive was damaged due to a failed
disk drive.

1 Go to Main Menu.

NOTE:  Replace the bad drive or add a stand-by drive for the rebuilding to function.

2 Type R or use the ↑ ↓ keys to select “Rebuild Logical Drive” and press [Enter] .

3 The controller will check for a spare drive and display the failed drive information.

4 To initiate rebuilding, press Y or use the ← → keys to select “Yes” and press
[Enter] .

5 Rebuilding for any other logical drives that needs rebuilding will continue. Oth-
erwise, the following message will appear:



ASUS PCI-DA2100 User’s Manual 43

II. TEXT RAID MANAGER

II. T
EX

T R
AID

 M
AN

AG
ER

Vi
ew

/E
dit

 S
CS

I C
ha

nn
els

View And Edit SCSI Channels

1 Go to Main Menu.

2 Type S or use the ↑ ↓ keys to select “View And Edit SCSI Channels” and press
[Enter] .

3 Use the ↑ ↓ keys to select a channel and press [Enter] .

The screen will now show the following menu:

SCSI ID
1 To change the SCSI ID, type I  or use the ↑ ↓ keys to select “SCSI ID” and press

[Enter] .

2 Use the ↑ ↓ keys to select the SCSI ID number and press [Enter] .
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II. TEXT RAID MANAGER

II. TEXT RAID MANAGER
View/Edit SCSI Channels

3 When the following prompt appears, type “Y”  to confirm or use the ← → keys
to select “Yes” and press [Enter] .

SCSI Terminator
1 To enable or disable a SCSI channel’s active termination, type T or use the ↑ ↓

keys to select “SCSI Terminator” and press [Enter] .

2 Type Y or use the ← → keys to select “Yes” and press [Enter]  to toggle the
channel termination function.

Synch Transfer Clock
1. To change the default (4 ns) synchronous transfer clock rate that is negotiated by

the ASUS PCI-DA2100, type S or use the ↑ ↓ keys to select “Sync Transfer
Clock” and press [Enter] .

2 Type the desired clock rate. (See Synchronous Transfer Period under V. Appen-
dices of Part I: Hardware Installation .)

Wide Transfer
This function serves to enable or disable wide transfer for the SCSI bus.

1 Type W or use the ↑ ↓ keys to select “Wide Transfer” and press [Enter] .

2 Type Y or use the ← → keys to select “Yes” and press [Enter]  to disable the
Wide transfer.
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View And Edit Configuration Parameters

1 Go to Main Menu.

2 Type C or use the ↑ ↓ keys to select “View And Edit Configuration Parameters”
and press [Enter] . The screen will display the following menu:

Communication Parameters
1 To modify the baud rate used for the RS-232 Terminal Interface Operation, type

C or use the ↑ ↓  keys to select “Communication Parameters” and press [Enter] .

2 Press [Enter]  or type B to select “COM Port Baud-Rate”.

3 Type the initial unit (highlighted, for example, “9” for 9600 or “3” for 38400) or
use the ↑ ↓  keys to select the desired baud rate and press [Enter] .

4 When prompted, type Y to confirm the change in the setting or use the ← →
keys to select “Yes” and press [Enter] .
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Caching Parameters
1 To modify the cache parameters, type a or use the ↑ ↓  keys to select “Caching

Parameters” and press [Enter] . The screen will display the following menu:

Write-Back Cache
1 To toggle the Write-Back Cache setting, type W or use the ↑ ↓  keys to select

“Write Back Cache” and press [Enter] .

2 When the corresponding prompt is displayed, type Y to confirm the change in
setting or use the ← → keys to select “Yes” and press [Enter]  to enable data
write-back caching or vice versa.

Optimization for Random I/O
1 To toggle between the Optimization for Random or Sequential I/O setting, type O

or use the ↑ ↓  keys to select desired setting and press [Enter] .

2 When the corresponding prompt is displayed, type Y to confirm the change in
setting or use the ← → keys to select “Yes” and press [Enter]  to enable optimi-
zation for either random or sequential I/O.

Host Side SCSI Parameters
1 To set host side SCSI parameters, type H or use  the ↑ ↓  keys to select “Host Side

SCSI Parameters” and press [Enter] . The screen will display the following menu:

Maximum Queued I/O Count
1 To set the maximum queued I/O count, type Q and press [Enter]  or just press

[Enter]  to select “Maximum Queued I/O Count”.

2 Type or use the ↑ ↓  keys to select the desired count and press [Enter] .

3 When prompted, type Y to confirm the change in the setting or use the ← →
keys to select “Yes” and press [Enter] .

II. TEXT RAID MANAGER

II. TEXT RAID MANAGER
View/Edit Configuration
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Drive Side SCSI Parameters
1 To modify the drive side SCSI parameters, type D or use the ↑ ↓  keys to select

“Drive Side SCSI Parameters” and press [Enter] . The screen will display the
following menu:

SCSI Motor Spin-Up
This option determines whether or not the ASUS PCI-DA2000 Series sequences the
drives to start spinning in succession at five second intervals. Enabling such se-
quencing can help to prevent overloading the power supply when several drives spin
up at the same time.

1 To toggle the current setting Use the ↑ ↓ keys to select “SCSI Motor Spin-Up”
and press [Enter] .

2 When the corresponding prompt is displayed, type Y to confirm the change in
setting or use the ← → keys to select “Yes” and press [Enter]  to enable sequen-
tial motor spin-up.

SCSI Reset At Power-Up
This option determines whether or not the ASUS PCI-DA2000 Series asserts SCSI
bus reset during power-up initialization.

1 To toggle the setting use the ↑ ↓ keys to select “SCSI Reset At Power-Up” and
press [Enter] .

2 When the corresponding prompt is displayed, type Y to confirm the change in set-
ting or use the ← → keys to select “Yes” and press [Enter]  to enable power-up reset.

Disk Access Delay Time
1 To set the disk access delay time, type A and press [Enter]  or use the ↑ ↓  keys

to select “Disk Access Delay Time”.

2 Type or use the ↑ ↓  keys to select the desired time and press [Enter] .

3 When prompted, type Y to confirm the change in the setting or use the ← →
keys to select “Yes” and press [Enter] .
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Maximum Tag Count
1 To set the maximum tag count, type T and press [Enter]  or use the ↑ ↓  keys to

select “Maximum Tag Count”.

2 Type or use the ↑ ↓  keys to select the desired count and press [Enter] .

3 When prompted, type Y to confirm the change in the setting or use the ← →
keys to select “Yes” and press [Enter] .

Disk Array Parameters
1 To modify the disk array parameters, type i or use the ↑ ↓  keys to select “Disk

Array Parameters” and press [Enter] . The screen will display the following menu:

Rebuild Priority
1 To change the rebuild priority setting, type P and press [Enter]  or use the ↑ ↓

keys to select “Rebuild Priority”.

2 Type or use the ↑ ↓  keys to select the desired setting and press [Enter] .

3 When prompted, type Y to confirm the change in the setting or use the ← →
keys to select “Yes” and press [Enter] .

Verification on Writes
1 To change the verification on writes setting, type V and press [Enter]  or use the

↑ ↓  keys to select “Verification on Writes”.

2 Type or use the ↑ ↓  keys to select and enable or disable the desired verification
mode (Verification on LD Initialization Writes, Verification on LD Rebuild Writes,
Verification on LD Normal Drive Writes, Verification Write Data with Reads)
and press [Enter] .

3 When prompted, type Y to confirm the change in the setting or use the ← →
keys to select “Yes” and press [Enter] .

II. TEXT RAID MANAGER

II. TEXT RAID MANAGER
View/Edit Configuration
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Controller Parameters
1 To modify the controller parameters, type o or use the ↑ ↓  keys to select “Control-

ler Parameters” and press [Enter] . The screen will display the set controller name,
otherwise it will display the following menu:

Controller Name
1 To change the controller name, type N and press [Enter]  or use the ↑ ↓  keys to

select “Controller Name”.

2 Type new or desired name and press [Enter] .

3 When prompted, type Y to confirm the change in the setting or use the ← →
keys to select “Yes” and press [Enter] .

View And Edit Peripheral Devices

NOTE:  This feature is not supported
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System Functions

1 Go to Main Menu.

2 Type F or use the ↑ ↓ keys to select “System Functions” and press [Enter] .

3 The screen will display the following menu:

Mute Beeper
1 To disable the beeper setting, type M  or use the ↑ ↓ keys to select “Mute Beeper”

and press [Enter] .

2 When the corresponding prompt is displayed, type Y to confirm the change or
use the ← → keys to select “Yes” and press [Enter]  to disable beeper.

Change Password
1 To set or change the password, type P or use the ↑ ↓ keys to select “Change

Password” and press [Enter] .

2 If a password was set previously, you will be prompted to enter the old pass-
word.  Type the old password and press [Enter] .

3 A prompt to enter a new password will appear. Type the new password followed
by [Enter] .  You will be prompted to enter the new password twice.

4 When the prompt to enter the new password a second time appears, type the new
password followed by [Enter]  again.

II. TEXT RAID MANAGER

II. TEXT RAID MANAGER
System

 Functions
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Reset Controller
1 To reset the controller, type R or use the ↑ ↓ keys to select “Reset Controller”

and press [Enter] .

2 When thecorresponding prompt appears, type Y to confirm reset or use the ← →
keys to select “Yes” and press [Enter] .

Controller Maintenance
This menu item includes maintenance functions such as new firmware on BIOS
downloading,

1 Use the ↑ ↓ keys to select “Controller Maintenance” and press [Enter] .  The
following submenu will be displayed:

2 Use the ↑ ↓ keys to select the desired function and press [Enter] .

3 A prompt for confirmation similar to the following will be displayed.  Type Y to
confirm or use ← → keys to select “Yes” and press [Enter] .

4 With the other submenus, such as “Advanced Maintenance Functions”, a filename
may be required. In this case, type the filename to be downloaded and the full
path or location of the drivers and press [Enter] .
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View System Information

1 Go to Main Menu.

2 Type I  or use the ↑ ↓ keys to select “View System Information” and press [Enter] .

3 The screen will display information about your system, similar to the following:

NOTE:  The information displayed — CPU Type, Total Cache Size, Firm-
ware Version, Boot  Record Version, Serial Number, and Battery Backup —
are not user-configurable.

II. TEXT RAID MANAGER
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RAID Manager Options

1 Go to Main Menu.

2 Type O or use the ↑ ↓ keys to select “RAID Manager Options” and press [Enter] .

3 The screen will display options to manage your disk array systems, similar to
the following:

RAID Event Monitor
1 To toggle the setting, type M  or use the ↑ ↓ keys to select “RAID Event Moni-

tor” and press [Enter] .

2 When the corresponding prompt is displayed, type Y to confirm the change in set-
ting or use the ← → keys to select “Yes” and press [Enter]  to enable or disable
monitoring of RAID events.

Event Level
1 To toggle the setting, type L  or use the ↑ ↓ keys to select “Event Level” and

press [Enter] .

2 Use the ↑ ↓  keys to select the desired event level (All, Warning, and Alert) and
press [Enter] .

3 When prompted, type Y to confirm the change in the setting or use the ← →
keys to select “Yes” and press [Enter] .
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Monitor Period (sec)
1 To change the monitoring period, type P or use the ↑ ↓ keys to select “Monitor

Period” and press [Enter] .

2 When prompted, enter a new value, in seconds, and press [Enter] .
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The GUI RAID Manager allows you to control and monitor disk array systems,
using an easy-to-use graphical interface.

System Description
The GUI RAID Manager is a Windows-based program specifically designed for use
in managing disk array systems implemented using any of the ASUS line of PCI-to-
SCSI controllers. The GUI RAID Manager provides a user-friendly graphical inter-
face that facilitates understanding of the relationship between disk array elements
and simplifies the normally complicated process of array configuration. The GUI
RAID Manager also provides real-time reporting on the status of the entire array,
thus making the task of monitoring disk arrays virtually effortless.

The GUI RAID Manager complements the text-based RAID Managers providing
the same functionality, but with greater ease of use.

Feature Summary
• User-friendly graphical interface running under Windows NT or Windows 95.

• Supports the new line of ASUS PCI-to-SCSI RAID controllers.

• Communicates with the controllers via the Local Area Network (LAN), tele-
phone line, Internet, or PCI bus (PCI-to-SCSI controllers only).

• Supports multiple instances of RAID managers over the network, allowing mul-
tiple management sessions with a disk array system.

• Illustrates graphically and clearly the relationship between disk array elements.

• At-a-glance monitoring of the entire disk array status.

• Supports remote management over the network of host/agent running Windows
NT or Windows 95 via the Simple Network Management Protocol (SNMP).

• Provides standard disk array functions, including examining and modifying con-
troller configuration; viewing and monitoring configuration and status of physi-
cal drives; scanning in new physical drives; creating, deleting, and monitoring
configuration and status of logical drives; rebuilding logical drives; defining
spare drives; creating, deleting, and partitioning logical volumes; and mapping
logical volume partitions to specific host channels/LUNs.

• Enclosure management functions, including defining multiple customizable en-
closures, dimensions, and number of drives; monitoring physical drives, power
supply, fan, and temperature status; displaying relative location of failed physi-
cal drives for reduced risk of replacing the wrong drives.



56 ASUS PCI-DA2100 User’s Manual

III. GUI RAID MANAGER

III. GUI RAID MANAGER
Features

• Provides a log file for logging in various event occurrences, including the time
when an event occurs, event severity, and event description; log file can be ac-
cessed using any text editor program.

• Supports statistics monitoring for displaying I/O throughput history.

• Provides innovative, user-configurable event notification functions.

• Configurable severity level qualifying the event severity that will initiate
the selected notification sequence

• Configurable latency time between event occurrence and notification se-
quence initiation provides local administrator the option to abort issuance
of the notification sequence

• Pager/telephone notification via a local modem
• Provides user-configurable address book for keeping names and num-

bers to be paged/called, and message to be sent.
• Optional notification retransmission until addressee responds locally

at the console or remotely over the LAN, Internet, or modem.
• Configurable latency time between notification retransmission; can be

set to different values at different times of the day.
• E-Mail notification via the MAPI service of Windows NT or Windows 95

• Provides user-configurable address book for keeping names, E-mail
addresses, and messages to be sent.

• Broadcast notification over the LAN
• Provides user-configurable address book containing names/groups and

network addresses to which the specified message will be broadcast.
• Broadcasts user-configurable message along with the event description.

• Facsimile (FAX) notification via a local FAX/modem
• Provides user-configurable address book containing names, FAX num-

bers, and messages to be sent.
• User-configurable FAX messages sent along with the event description.
• Automatic message retransmission if previous transmission attempts fail.

• Provides password protection for guarding against unauthorized modification
of disk array configuration

• Provides Demo mode for use as a learning tool and for demonstration purposes.
You can perform experimentation on various disk array configuration and moni-
tor the performance of the system under such condition.
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Feature Highlights
Graphical User Interface
The GUI RAID Manager’s graphical interface is based on the Windows specifica-
tions. It draws symbolic icons representing physical and logical drives, and logical
volumes on the screen to identify the current configuration of a disk array system.
Pull-down and pop-up menus are used with all command options listed. You just point
and click the mouse button to select an icon or command. The program also identifies
the current status of various drives by changing the colors of their respective icons.

With the Windows interface, complicated disk array operations such as logical drive
and logical volume creation, drive partitioning, and drive partition mapping to host
channels/LUNs only involve a few mouse clicks.

Enclosure Management
The GUI RAID Manager provides a window dedicated to enclosure management.
Multiple customizable enclosures can be defined within this window, including the
number of drives per row and column, and drive orientation. Once an enclosure is
defined, drives can be dragged and dropped into their respective drive bays corre-
sponding to their actual locations. In this way, drives can be monitored in an enclo-
sure-relative context.

The enclosure window provides real-time reporting of the status of the connected
physical drives. When a drive fails, the system highlights the corresponding icon of
the failed drive by placing a red X mark on it; when you remove a drive, its icon is
removed from the enclosure window. This feature is particularly useful in cases where
a drive fails, and you need to identify its exact location for subsequent replacement.

In addition to monitoring drives in the enclosure, the enclosure window also allows
you to monitor the status of the power supply, fan, temperature inside the enclosure,
and uninterruptible power supply (UPS) supplying power to the enclosure.
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Powerful Event Notification Function
The GUI RAID Manager sends notifications to administrators for reporting event
occurrences and status changes of the disk array system. These notifications can be
sent via a local modem to a pager or telephone, via the Internet as E-mail messages,
via a LAN as broadcast packets, or via FAX/modem as FAX messages. Any number
of notification destinations can be set with messages user-configurable through the
address book. Optional notification retransmission can be activated for each desti-
nation to ensure message reception by the intended addressee. Furthermore, you can
specify retry periods depending on your specific needs.

Remote Management via SNMP or Modem
The GUI RAID Manager supports remote management of the disk array controllers
over a LAN using SNMP, or over the telephone line using a dial-up modem. Man-
agement over the LAN is achieved through the exchanges of SNMP management
packets between the remote GUI RAID Manager station and the SNMP agent on the
Windows NT or Windows 95 local host. The remote GUI RAID Manager sends
management requests to the SNMP agent, which in turn checks the connected con-
troller, and then sends back a reply to the requesting manager. The following figure
shows a typical SNMP connection:
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Password Protection
The GUI RAID Manager comes with password protection to prevent unauthorized
users from maliciously modifying the configuration of the disk array system. This
security feature is put into effect the first time an attempt is made to modify the disk
array configuration after turning on the GUI RAID Manager station or after the
station comes back from a period of inactivity.

With the password security feature, you have the luxury of leaving your GUI RAID
Manager station unattended knowing that the currently managed disk array system
is safe from any unauthorized modifications.

Demo Mode
The GUI RAID Manager provides a Demo program for use as a learning tool and
for demonstration purposes. This tool allows you to experiment on various disk
array configuration and monitor how the system responds and operates under such
condition without connecting to a real disk array.

This Demo program supports all management functions available in the GUI RAID
Manager, making your imaginary system as real as possible. You can select the
controller for your imaginary system and drive channels, the number of physical
drives, configure your logical drives and volumes, partition logical volumes, and
map partitions to hosts. You can even force drives to fail and observe the system’s
reaction.
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This section contains information about hardware and software setup for local and
remote management and downloading the latest version of the GUI RAID Manager.

System Requirements
The minimum hardware and software requirements for the GUI RAID Manager
depends on the conditions it will be run.

Systems Running the GUI RAID Manager
• IBM-compatible 386 or above running Windows NT or Windows 95

• At least 8 MB of RAM

• At least 3 MB of free hard disk space

• VGA monitor

• Microsoft-compatible mouse

• At least one available RS-232 port (if remote management over the telephone
line is desired)

• Hayes-compatible modem (if pager/telephone event notification is desired) or
FAX/modem (if FAX event notification is desired)

• SNMP service for Windows NT (if SNMP remote management is desired)

Local Hosts Running the ASUS SNMP Agent
(For SNMP Remote Management Only)
• IBM-compatible 386 or above running Windows NT or Windows 95

• SNMP service for Windows NT/Windows 95 (if SNMP agent is under Windows
NT or Windows 95 environment)
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Hardware Setup
The GUI RAID Manager supports both local and remote management of the disk
array systems from ASUS.  Local management refers to management of the disk
array from a local host — management transactions traverse the PCI bus (for PCI-
to-SCSI controller). Remote management refers to management of the disk array
from a remote station connected to the controller either via a modem or through a
network cable.

NOTE:  Management through the RS-232 interface requires an RS-232 port.
Thus this interface cannot be used on the ASUS PCI-DA2100, which does not
have an RS-232 port on board.

Typically, management will be done locally.  A local host runs the GUI RAID Man-
ager to configure and monitor the connected controller.  Local management is sim-
pler than remote management for it requires less hardware in its configuration.  Re-
mote management is more complicated than local management but provides the fol-
lowing benefits:

• Allows management even at distant remote places. Since remote management utilizes
the network cable or the telephone line, management anywhere around the globe is
possible.  All you need is a simple attachment to an existing network where the disk
array’s host exists, or dial up the number of the modem connected to the controller.

• Allows multiple instances of GUI RAID Manager stations over the network
managing concurrently  a particular disk array system.

Depending on your specific needs and configuration requirements, you may perform
management either from a local host or from a remote station.  The following sec-
tions describe how to set up your hardware for local and remote management.

Local Management
For local management, the controller is either installed in (for PCI-to-SCSI control-
ler) or connected to (for SCSI-to-SCSI controller) the host. The following figure
illustrates a typical setup for a PCI-to-SCSI controller:
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Since the controller is already installed in the host, no extra connection is necessary.
Just load the necessary driver for the controller and then run the GUI RAID Manager
from the local host to start management of the disk array system.

Remote Management
You can set up your hardware two ways in remote management:  network and tele-
phone.  Network setup provides a faster data transfer rate than the telephone setup
because it utilizes the network bandwidth, for example, 10 Mbps (million bits per
second) for Ethernet and 100 Mbps for Fast Ethernet.  Another advantage of using
the network is you can have your GUI RAID Manager station manage other disk
array systems on the network.  Alternatively, you can manage the disk array system
from other GUI RAID Manager stations on the network.

Network setup requires running the GUI RAID Manager on the target manager
station(s), and enabling the SNMP service on the local host.  The following figure
illustrates a typical network setup:

The PCI-to-SCSI controller does not support direct connection to a modem for
remote management. To manage this controller using the modem, you will need
to connect the modem instead to the local host’s serial interface. This user’s
guide does not provide information on this type of configuration.
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Software Setup
This section discusses how to set up the GUI RAID Manager in your system.  Before
proceeding with the setup procedure, read through the notes listed in the Before You
Start section.  You will need the information provided in this section to complete
setup successfully.

Before You Start
Before starting with setup, read through the notes listed below, and ensure that you
understand each.  These notes will help facilitate the setup process for you.  If you
need additional information, see the Hardware Setup section.

• Ensure that your system meets the minimum hardware and software require-
ments listed in the System Requirements section.

• Ensure that the disk array system is installed properly.  For the installation proce-
dure, see the documentation that came with the controller.

• For local management (that is, management from the local host) and remote
management via the telephone line, you will only need to set up for a Local
Manager Site.  For fast setup, just accept the default values presented by the
setup program.

• For remote management over the network using SNMP, ensure that the remote
manager station has Windows NT.  You will need to set up for an SNMP Manager
Site on the remote station, and SNMP Agent Site on the local host.  The setup
program helps you achieve these tasks by providing setup options.

Setting Up the GUI RAID Manager
Follow these steps to set up the GUI RAID Manager on your system:

1. Insert DISK1 into the appropriate disk drive.
2. Run SETUP.EXE from DISK1.  The setup welcome screen appears:
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3. If you are currently running other applications, close them first before proceed-
ing with the setup process.  This will minimize the possibility of encountering
system errors during setup.  Then, click OK to continue.

4. To accept the default destination directory, click on the setup button at the top
left portion of the screen; to specify a different directory, click on the Change
Directory button and then specify the directory you want.  The following screen
will then appear:

5. Select the appropriate option for the type of system on which you are setting up
the GUI RAID Manager.  If you are setting up on a host where array management
will be performed, you only need the Local Manager Site option (selected by
default); for a local host where SNMP transactions from remote manager sta-
tions will be processed, you need the SNMP Agent Site option; for a remote
manager station where array management will be performed over the network,
you need the SNMP Manager Site option.
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To select an option, just check its corresponding check box.  You may select
more than one option if you want; be reminded though that the more options you
select, the bigger the disk space requirement will be.  Click Continue to proceed.

6. If you select the SNMP Agent Site option, the following message will appear:

If you select the same option, and the SNMP service is not installed to your
system, this message appears:

Follow the instruction displayed on the screen.  Click OK to continue.
Setup will then start copying the necessary files to the selected directory.  After
copying the files, the following screen will be displayed:

7. Click OK.

8. If necessary, restart the SNMP service.

Setup is complete.  You may now start managing the disk array system.  For informa-
tion on first time operating instructions, see “Basic Operations at Startup.”

Software Upgrades
As a valuable customer of ASUS, you are entitled to free program upgrades.  You
can download the latest GUI RAID Manager either from our BBS or any of our
Internet sites (WWW/Gopher/FTP). For more information about this service, see
the contact information on page 3 or call your local distributor or dealer.
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Basic Operations at Startup

This section discusses the basic operations you may want to learn first and tasks you
may want to take care of when you start the GUI RAID Manager for the first time.

Starting the GUI RAID Manager
Depending on your hardware setup, you can start the GUI RAID Manager in various
ways. For local management, your task is quite simple. Refer to the appropriate
section below for information.

Under Windows 95 or Windows NT 4.0
1. From the Start menu, select Programs → ASUS GUI RAID Manager .

-or-

Double-click the ASUS GUI RAID Manager icon. The ASUS GUI RAID Man-
ager main window appears on the screen.

2. Connect to the disk array system. For information on how to connect, see the
Connecting and Disconnecting from a Disk Array System section.

Under Windows NT 3.5x
1. Open the ASUS GUI RAID Manager group window from the Program Man-

ager, if not yet open.

2. From the ASUS GUI RAID Manager group window, double-click the ASUS
GUI RAID Manager icon. The ASUS GUI RAID Manager main window ap-
pears on the screen.

3. Connect to the disk array system. For information on how to connect, see the
Connecting and Disconnecting from a Disk Array System section.

For remote management, see the appropriate section below.

For Remote Management Via Network
1. Turn on the local host and enable the appropriate SNMP service. For informa-

tion on how to enable the SNMP service for Windows NT, Windows 95, or
Novell NetWare, see their respective manuals.

2. Check to ensure that the local host is properly connected on the network. Take
note of its IP address (or SNMP agent’s name) and community names.
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3. Run the GUI RAID Manager on the remote station. If you are using Windows
95 or Windows NT 4.0, follow these steps:

3a. From the Start menu, select Programs → ASUS GUI RAID Manager.

-or-

Double-click on the ASUS GUI RAID Manager icon. The ASUS GUI RAID
Manager main window appears on the screen.

If you are using Windows NT 3.5x, perform these steps:

3a. Open the ASUS GUI RAID Manager group window from the Program
Manager, if not yet open.

3b. From the ASUS GUI RAID Manager group window, double-click on the
ASUS GUI RAID Manager icon. The ASUS GUI RAID Manager main
window appears on the screen.

4. Connect to the disk array system. For information on how to connect, see the
Connecting and Disconnecting from a Disk Array System section.
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Connecting and Disconnecting from a Disk Array System
The GUI RAID Manager provides a feature that facilitates connection and discon-
nection from disk array systems. Before management can be performed on a par-
ticular disk array system, you need to establish first a connection between your GUI
RAID Manager station and the target system. Once a connection is established suc-
cessfully, management can be started.

Disconnection is used for breaking the link between the GUI RAID Manager station
and the array system. This option is particularly useful in cases where multiple disk
array systems are being managed at the same time — instead of restarting the GUI
RAID Manager every time you need to switch to another system, you just need to
disconnect from the current system and then connect to a new one.

The following discusses the various ways of connecting to a disk array system.
Information on disconnection is provided at the latter part of this section.

Connecting to a PCI-to-SCSI Controller from the Local Host
1. From the File menu, select Connect.

-or-

Click on the Connect/Open command button. The following submenu appears
on the screen:

Note that there will be one PCI Bus entry for each PCI-to-SCSI controller in-
stalled. If none are installed, then no PCI Bus entries will be displayed.

2. Select the corresponding entry for a PCI-to-SCSI controller. Based on the previ-
ous figure, the entry should be PCI Bus #0 PCI Dev#12 Port:D000 Irq:11.

The enabling of the toolbar buttons signifies a successful connection.
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Connecting to a PCI-to-SCSI Controller
from a Remote Station (Via Network)
1. From the File menu, select Connect.

-or-

Click on the Connect command button. The following submenu appears on the
screen:

2. Select SNMP. The Settings of SNMP Interface dialog box appears on the screen:

3. In the Agent Name or IP Address text box, type in the IP address of the local
host where the target disk array system is connected. Alternatively, you may
specify the host name of the local host.

4. In the Community Name text box, type in one of the community names of the
SNMP agent. Community names act as passwords that screen accesses to the
SNMP agent of a particular network device. Before access is granted to a re-
questing station, this station must incorporate a valid community name to its
request; otherwise, the SNMP agent will deny access to the system.

By default, most network devices use “public” as one of their community names.
This value is case-sensitive.
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5. In the Agent-side Communication Type section, click on the Host Bus Inter-
face option button. Then, select the corresponding index of the controller in the
Controller Index  drop-down list box. To select, click on the down-arrow button
at the right of the box, then select the option you need.

6. Click OK.

The enabling of the toolbar buttons signifies a successful connection.

Disconnecting from the Disk Array System
1. From the File menu, select Disconnect.

All toolbar buttons, except the Connect and Notification  command buttons,
turn gray signifying disconnection from the current disk array system.
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Setting Up Security
The GUI RAID Manager provides password protection to prevent unauthorized modi-
fication of the system configuration. This protection, which is implemented on the
GUI RAID Manager station, prompts a user for the station password the first time he
or she attempts to modify the disk array settings after turning on the GUI RAID
Manager station or after the station comes back from a period of inactivity. Specify-
ing the correct password gives the user full control over the disk array system; speci-
fying otherwise, only allows the user to view the current configuration of the system.

By default, the GUI RAID Manager station comes without any password, thus when
prompted for the password for the first time, just press ENTER. After gaining con-
trol, set a password to provide security to the managed disk array system. The set
password will be saved into the memory of the GUI RAID Manager station.

You can also set an inactivity time, which will determine when to reactivate the
password security feature after a period of station inactivity. If, within the specified
period, there is no activity from the keyboard or mouse, this security feature will be
put back into effect - prompting again for the station password the first time there is
an attempt to modify the disk array configuration. This feature is particularly useful
in protecting unattended GUI RAID Manager stations.

Setting a Password for the
GUI RAID Manager Station
1. Display the Physical Drives window by clicking the Physical Device command

button or selecting the Physical Drive command from the Open menu.

2. From the Physical Drive window, double-click the displayed controller (that is,
the card layout for the ASUS PCI-DA2100 RAID controller). The Controller
Settings window appears.
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Displaying and Hiding the Toolbar
The GUI RAID Manager provides a toolbar located just beneath the menu bar for
displaying the available command buttons. These buttons serve various purposes,
which are described in detail in the Working with Windows section.

You have the option to display or hide the toolbar depending on your specific needs.
If you need bigger working space for viewing the various disk array elements or for
executing various management operations, hide the toolbar; if you need to use the
command buttons for simplified operations, unhide the toolbar.

You also have the option to hide the status bar located beneath the windows display
area for even bigger working space. For information about this option, see the Dis-
playing and Hiding the Status Bar section next.

3. Click Controller  → Change Password. The Change Password dialog box appears.

4. Type the password you want in the New Password text box taking note that the
password is case-sensitive. Retype the password in the Verify Password text
box to confirm.

5. Click OK.
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Hiding the Toolbar
• From the View menu, click on Toolbar until the check mark ü next to this

command disappears.

The toolbar will disappear from the ASUS GUI RAID Manager main window.

Redisplaying the Toolbar
• From the View menu, click on Toolbar until a check mark ü appears next to this

command.

The toolbar is displayed back in the ASUS GUI RAID Manager main window.

Displaying and Hiding the Status Bar
The status bar at the bottom of the windows display area supplies information about
the results of the different disk array operations, and errors that occur on the system.

You can hide or display the status bar depending on your particular needs. If you
need bigger working space, you can hide the status bar; if you are closely monitor-
ing the status of the disk array system, unhide the status bar for a real-time report on
the condition of the system.

You also have the option to hide the toolbar found just beneath the menu bar for
even bigger working space. For information about this option, see the previous sec-
tion, Displaying and Hiding the Toolbar.

Hiding the Status Bar
• From the View menu, click on Status Bar until the check mark ü next to this

command disappears.

The status bar will disappear from the ASUS GUI RAID Manager main window.

Redisplaying the Status Bar
• From the View menu, click on Status Bar until a check mark ü appears next to

this command.

The status bar will reappear in the ASUS GUI RAID Manager main window.
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Working with Windows
Just like any other Windows-based applications, the GUI RAID Manager works en-
tirely with windows to facilitate various disk array operations. These windows fol-
low the standard MS Windows specifications, thus steps for manipulating elements
and windows within any GUI RAID Manager windows conform to the standard MS
Windows procedures.

This section describes how to work with the GUI RAID Manager windows.

Using the Main Window
After starting the GUI RAID Manager, the ASUS GUI RAID Manager main win-
dow appears on the screen. All management operations pertaining to the disk array
system will be performed within the main window. The following describes the
various components found on the main window:

• The menu bar displays the available menus. Except for Options, all menus
provide a list of commands for invoking various disk array and Windows-
related operations. Most commonly used commands such as Statistics and
Event Log come with command buttons to facilitate their execution - you
can either select the command from the menu, or click on its respective
command button on the toolbar. For a summary of the available commands,
see Appendix A, Command Summary.

• The GUI RAID Manager provides command buttons to assist in the execu-
tion of most commonly used commands. These buttons are displayed on
the toolbar, which can be hidden if bigger working space is required for
certain management operations. For information on how to hide the toolbar,
see the Displaying and Hiding the Toolbar section.
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The following figure displays the command buttons on the toolbar:

• The Connect/Open command button is used for connecting to a disk array
system when you start the GUI RAID Manager. This button has the same
function as the Connect command in the File menu. After establishing a
connection with the target disk array system, this button changes to an Open
button; this time, providing the same function as Open in the menu bar.

• The Tile In-Sequence command button arranges the displayed windows
next to each other, with arrangement based on their uses, and each window
reduced to fit all elements within its width. This button, however, only
affects the Enclosure, Physical Drives, Logical Drives, Volume, Host LUN
Assignment, and Statistics windows. This button has the same function as
the Tile In-Sequence command in the Window menu.

• The Enclosure command button displays the Enclosure window for defin-
ing customizable enclosures. This button provides the same function as
the Enclosure command in the Open menu.

• The Physical Drives command button displays the Physical Drives win-
dow for configuring the controller and the physical drives included in the
disk array system. This button provides the same function as the Physical
Drive command in the Open menu.

• The Logical Drives command button displays the Logical Drives window
for creating and configuring logical drives in the disk array system. This
button provides the same function as the Logical Drive command in the
Open menu.

• The Logical Volume command button displays the Volume window for
defining and configuring logical volumes in the disk array system. This
button provides the same function as the Logical Volume command in the
Open menu.
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• The Host LUN Assignment command button displays the Host LUN As-
signment window for assigning logical volume partitions to various host
LUNs. This button provides the same function as the Host LUN Assign-
ment command in the Open menu.

• The Event Log command button displays the Event Log window for view-
ing the contents of the log file. This button provides the same function as
the Event Log command in the Open menu.

• The Notification  command button allows you to specify the notification
configuration of the disk array system. This button provides the same func-
tion as Notification  in the menu bar.

• The Statistics command button displays the Statistics window for moni-
toring the performance of the disk array system. This button has the same
function as the Statistics command in the Open menu.

• The windows display area is where the system displays the GUI RAID
Manager windows. You have the option to arrange the displayed windows
on this area in various ways depending on your specific needs. The Win-
dow menu provides you with the commands you will need to arrange these
windows. For information on how to do this, see the Arranging Windows
section.

• The status bar displays results of various disk array operations, error mes-
sages, and information about specific elements in the system. You have the
option to hide the status bar to free some space on the windows display
area. For information on how to hide the status bar, see the Displaying and
Hiding the Status Bar section.

• The scroll bars let you move parts of a window into view when the entire
window does not fit into the windows display area.

Using the Enclosure Window
The Enclosure window appears when you click on the Enclosure command button
or select the Enclosure command from the Open menu. The Enclosure window
allows you to define customizable enclosures for creating an exact replica of the disk
array’s drive bays, displaying the exact location of the physical drives, power supply,
and fan. In addition, the Enclosure window helps you monitor the temperature inside
the drive bays. (“ Array Management” provides detailed information on how to cre-
ate enclosures.)
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The Enclosure window is particularly useful in monitoring the status of the physical
drives. It provides you with a real-time report on the drive status, using symbols and
colors to represent various conditions. The following figure illustrates how the GUI
RAID Manager represents the various drive conditions:

The system places an X mark on the icon of a failed drive. Spare drives appear with
their colors darker (shaded) than normal drives (for example, for the first logical
drive, normal drives appear in yellow while the spare appears in dark yellow). When
you remove a drive from the drive bay, its corresponding icon on the Enclosure win-
dow disappears.

NOTE:  The Physical Drives window also provides you with a real-time report
on the drive status, using the same symbols and colors to represent various con-
ditions. What you see on the Enclosure window is also reflected on the Physical
Drives window. These windows though differ in the way physical drives are
presented; in the Enclosure window, the drives are arranged according to their
actual locations in the drive bays, while in the Physical Drives window, the
drives are arranged according to the connectors they connect onto.

You can also display some information about a particular drive by simply placing the
mouse pointer on its respective icon. A table similar to the following appears:
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This table displays the current configuration of the drive, including the drive’s slot
number, the channel number of the connector on the controller to which the drive’s
SCSI cable is connected, the ID number of the connector on the SCSI cable where
the drive is installed, the drive’s capacity, status, transfer rate, the ID number of the
logical drive where the drive belongs (if there is one), and the drive’s manufacturer
(if available).

To facilitate management of the Enclosure window, the GUI RAID Manager sup-
ports the drag-and-drop function for moving objects within the Enclosure window.
If you need to move an object to a different location within the window, just drag its
corresponding icon to the target destination.

Using the Physical Drives Window
The Physical Drives window is where you view and modify the configuration of the
controller and manage physical drives. This window provides almost the same func-
tion as the Enclosure window, using the same symbols and colors to represent vari-
ous drive conditions (for information about these symbols and colors, see the previ-
ous section, Using the Enclosure Window). The main difference between these two
windows is in the way they present the physical drives; the Enclosure window pre-
sents the drives according to their actual locations in the drive bays, while the Physi-
cal Drives window presents them based on the connectors they connect onto.

To display the Physical Drives window, you can either click on the Physical Drives
command button or select the Physical Drives command from the Open menu. A
window similar to the following will appear on the screen:

Depending on the controller you are using, this window displays either the front
panel of a SCSI-to-SCSI controller or the card layout of a PCI-to-SCSI controller.
The front panel display reflects what appears on the actual front panel of a SCSI-to-
SCSI controller.
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Also shown in this window are the physical drives and hosts (for SCSI-to-SCSI
controllers only) connected to the controller. How they are connected and config-
ured, including their current status (for drives only), are all depicted on the screen. If
you need information about a particular object in this window, simply place the
mouse pointer on its respective icon. Letting the mouse pointer hover over the front
panel displays the following table:

This table shows some information about the controller, including the total cache
size, the version of the firmware currently stored in the Flash memory, the boot
record version, serial number, and the CPU type.

Letting the mouse pointer hover over a SCSI Channel displays a table similar to the
following:

This table provides information pertaining to the current configuration of the SCSI
channel. This includes the channel number, channel mode (that is, host or drive),
SCSI ID, the default and current transfer clock rate, and the default and current
transfer width.

Letting the mouse pointer hover over a drive displays a table similar to the following:

This table displays the current configuration of the drive, including the drive’s slot
number, the channel number of the SCSI channel to which the drive is connected,
the SCSI ID of the drive, the drive’s capacity, current status, transfer rate, the ID
number of the logical drive to which the drive belongs (if it belongs to one), and the
drive vendor and product identifier strings (if available).
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The Physical Drives window also allows you to modify the configuration of the
controller and the SCSI channels, and scan in newly added or replaced physical
drives. For more information about this feature, see “Array Management.”

Using the Logical Drives Window
The Logical Drives window is where you perform management on the logical drives
of the disk array system. Logical drives are combinations of physical drives, which
are used to create logical volumes. These volumes (or their partitions) can then be
mapped to various host LUNs.

The Logical Drives window allows you to create logical drives, delete existing ones,
and rebuild failed drives. It uses unique colors to distinguish between logical drives.
When a physical drive within a logical drive fails, the system notifies you by darken-
ing the color of the affected logical drive. The logical drive will remain in this state
until either a spare is detected and rebuilding is automatically started, or the drive is
replaced and rebuilding is manually initiated.

While rebuilding a logical drive, the GUI RAID Manager reports the progress of the
rebuilding process by filling in the color of the logical drive accordingly. After re-
building is complete, the logical drive will display its normal color, signifying on-
line condition.

To facilitate management of the Logical Drives window, the GUI RAID Manager
supports drag-and-drop operations to establish certain associations. For example, to
assign a particular physical drive as a spare to a logical drive, just drag the desired
physical drive over to the logical drive window and drop it into the target logical
drive.

To display the Logical Drives window, you can either click on the Logical Drives
command button or select the Logical Drives command from the Open menu. A
window similar to the following will appear on the screen:
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If you need information about a particular logical drive, just let the mouse pointer
hover over its corresponding icon. A table similar to the following will appear:

This table displays the ID number of the logical drive, the RAID level, total capac-
ity, current status, total number of physical drives combined to create this logical
drive, number of spare drives, and number of failed drives.

For more information on how to create, delete, and rebuild logical drives, see “Ar-
ray Management.”

Using the Volume Window
The GUI RAID Manager provides a Volume window for use in the management of
logical volumes in the disk array system. Logical volumes are a grouping of mul-
tiple logical drives combined together into one large unit. This unit is, in turn, mapped
entirely or by parts (that is, by partitions) to various host LUNs.

NOTE:  A logical volume can contain a maximum of eight logical drives with
dissimilar RAID levels.

The Volume window helps you create logical volumes, delete existing ones, and
define partitions. It supports the drag-and-drop operation to simplify management
of these disk array elements — you simply drag logical drives over to the Volume
window and drop them into the logical volume being created.

To display the Volume window, you can either click on the Logical Volume com-
mand button or select the Logical Volume command from the Open menu. A win-
dow similar to the following will appear on the screen:
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The GUI RAID Manager uses a book icon to represent a particular volume, with the
binding displaying the respective colors of the logical drives used to create this
particular volume. The relative size of the colored area reflects the capacity of the
respective logical drive relative to the total capacity of the logical volume.

Logical volumes that have been partitioned appear with dotted lines on them. The
relative position of a dotted line indicates the location of the boundary between par-
titions within the volume. Moving this line will change the location of the boundary
thereby changing the size of the partitions so bounded.

If you need information about a particular logical volume, simply let the mouse
pointer hover over its corresponding icon. A table similar to the following will ap-
pear:

This table displays information about the existing partitions of a logical volume. These
include the total number of partitions into which the volume has been divided and
their respective sizes. This table also displays the volume ID and its total capacity.

For information on how to create, delete, and set partitions for logical volumes, see
“Array Management.”

Using the Host LUN Assignment Window
The Host LUN Assignment window depicts the Logical Unit Numbers (LUNs) for
the existing host channels in the disk array system with their current logical volume
and/or partition assignments. Depending on the type of controller used in the sys-
tem, this window displays one or more host channels; the PCI-to-SCSI controller
only supports one host channel (that is, the PCI bus itself). Each host LUN appears
to the host on one access letter with a capacity equal to the mapped volume (or
partition).

To display the Host LUN Assignment window, you can either click on the Host LUN
Assignment command button or select the Host LUN Assignment command from
the Open menu. A window similar to the following appears on the screen:
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This window displays the available host channels and their respective LUN assign-
ments. LUNs with mapped volumes or partitions appear with book icons on their
connectors. These icons are similar to those used for logical volumes only that they
appear smaller. If you need information on any of these mappings, just place the
mouse pointer on the target book icon. A table similar to the following appears on
the screen:

This table displays the SCSI number for the respective host channel, the LUN num-
ber, the index number of the logical volume used in this mapping, the partition in-
dex, and the capacity.

For information on mapping logical volumes and/or partitions to host LUNs, and
deleting existing mappings, see”Array Management.”
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Arranging Windows
The Window menu provides you with commands for rearranging the displayed GUI
RAID Manager windows (excluding the main window) in various ways. You have
the option to cascade these windows so that they will overlap with each other making
their title bars visible, arrange the open windows in smaller sizes to fit next to each
other on the screen, or display the windows in such a way that they appear according
to their uses and the maximum number of elements are displayed.

All commands in the Window menu are standard MS Windows commands, except
for Tile In-Sequence. The Tile In-Sequence command is specifically designed for
disk array management. It arranges the open windows based on their uses, with each
window reduced to fit all elements within its width. Since all elements within the
width are displayed, a horizontal scroll bar is not necessary for each window; how-
ever, for the main window, it might be necessary specially when multiple windows
are displayed.

Arranging Windows Using the Tile In-Sequence Command
• From the Window menu, select Tile In-Sequence.

-or-

• Click on the Tile In-Sequence command button.

Cascading the Displayed Windows
• From the Window menu, select Cascade.

Arranging Windows Using the Tile Horizontal Command
• From the Window menu, select Tile Horizontal .

Arranging Windows Using the Tile Vertical Command
• From the Window menu, select Tile Vertical .

Exiting GUI RAID Manager
Exiting from the GUI RAID Manager terminates the current management session
with the disk array system. When you exit, the system automatically saves the disk
array configuration for use later when connecting to the same system. The system
also releases all used or occupied resources for use by other applications.

Exiting from the GUI RAID Manager
• From the File menu, select Exit .
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Disk Array Management

This section describes the steps on managing a disk array system.

If this is your first time to manage a disk array system, we recommend that you read
through the first section, Background Information, to get basic information about
disk array management. You will need this basic knowledge to be able to use effec-
tively the GUI RAID Manager.

Background Information
Redundant Arrays of Independent Disks (RAID) is a storage technology used to
improve the processing capability of storage systems. This technology is designed
to provide reliability in disk array systems and to take advantage of the performance
gains multiple disks can offer.

RAID comes with a redundancy feature that ensures fault-tolerant, uninterrupted
disk storage operations. In the event of a disk failure, disk access will still continue
normally with the failure transparent to the host system.

RAID has six levels: RAID 0–RAID5. RAID levels 1, 3 and 5 are the most com-
monly used levels, while RAID levels 2 and 4 are the less popular ones. In the
appendices, RAID Levels gives information about these levels, including the ben-
efits of each.

Infortrend disk array controllers support hot-swapping where a failed drive can be
replaced while the disk array system continues to function. Spares can also be as-
signed so that, as soon as a drive fails, the spare will be automatically configured
into the array and reconstruction will commence.

Definition of Terms
• Physical drives. These are the actual SCSI drives installed on the connectors of

the SCSI cables. These drives are displayed on the Physical Drives window.

• Spare drives. These are physical drives that serve as backups. When a drive
fails, the spare is automatically configured into the array, and data reconstruc-
tion will immediately commence. Spare drives appear in darker (shaded) colors
than normal drives.

• Replacement drives. These are physical drives that are manually configured into
the array to replace failed drives. In the absence of spare drives, you will need to use
replacement drives to replace defective drives before rebuilding can be performed.
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• Failed drives. These are physical drives that fail due to errors of some type.
Failed drives appear with X marks on their respective icons.

• Logical drives. These drives are created using physical drives. Combining physi-
cal drives into one logical drive gives you a disk array with a certain RAID
level. To view logical drives, use the Logical Drives window.

• Logical volumes. These volumes are created using logical drives. Combining
logical drives into one logical volume gives you a single logical unit with even
larger capacity. Logical volumes or their partitions are mapped to various host
LUNs. To view logical volumes, use the Volume window.

Operation With Spare Drives
You can assign spare drives to a particular logical drive to serve as backup drives.
When a drive fails within the logical drive, one of the spares will be automatically
configured into the logical drive, and data reconstruction onto it will immediately
commence.

The following are guidelines for disk failure recovery when a spare drive is available:

• If a spare drive exists in the same logical drive, the controller will automatically
mount the spare drive and start data rebuilding in the background.

• Depending on the design of the system external to the controller, it may be pos-
sible to remove a defective drive and replace it with a new drive without shut-
ting down the system (hot-swapping). Alternatively, the system can be shut down
at a convenient time and the failed drive replaced.

• The replacement drive must then be assigned as a new spare drive.

Operation Without Spare Drives
The following are guidelines for disk failure recovery when a spare drive is available:

• Depending on the design of the system, it may be possible to remove a defective
drive and replace it with a new drive without shutting down the system (hot-
swapping). Alternatively, the system can be shut down at a convenient time and
the failed drive replaced.

• If the replacement drive is installed on the same channel and SCSI ID, you can
then proceed with data rebuilding.

• If the replacement drive is installed on a different channel or SCSI ID, you need
to scan in the new drive first then assign it as a spare drive of the logical drive.
Data rebuilding will have to be manually initiated.
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IMPORTANT:  Although the RAID system provides uninterrupted disk access
even after a disk failure, do not leave a failed drive unattended to. Without re-
placement, the system will not survive a failure of a second drive on the same
logical drive. A defective drive must be promptly replaced and data rebuilt.

CAUTION:  When performing hot-swapping, be sure to remove only the defective
drive. Removing the wrong drive will result in unrecoverable data loss. Use the
Enclosure or Physical Drives window to locate the exact location of the failed drive.

Before You Start
The GUI RAID Manager station comes with password protection that prevents un-
authorized modification of the disk array configuration. During first attempts at modi-
fying the system configuration after starting up the GUI RAID Manager or after the
GUI RAID Manager comes back from a period of inactivity, the configuration will
be password protected. After specifying the correct password, all subsequent con-
figuration modifications will be permitted without any password protection; how-
ever, if there is no station activity within a specified period of time, the password
will be put back into effect.

By default, the GUI RAID Manager station comes without any password. For infor-
mation on how to set a password and other security features, see the Setting Up
Security section under “Basic Operations at Startup.”

Defining Enclosures
You create custom enclosures to facilitate management of the physical drives in the
disk array system. These enclosures can replicate closely real enclosures with real
drive bays, depicting the exact locations and positions of the physical drives. When
a drive fails, determining which drive to replace is simply a matter of checking the
Enclosure window for the exact location of the failed drive (a failed drive appears
with an X mark on its icon).

Creating an Enclosure
1. Display the Enclosure window, if not yet displayed. To display it, click on the En-

closure command button or select the Enclosure command from the Open menu.

If you have not defined an enclosure yet for the disk array system, the Enclosure
window will be blank; otherwise, the existing enclosures appear in the window.
If you want to delete an existing enclosure, see the instructions below.

2. Double-click on an empty space within the Enclosure window. The following
menu will appear:
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3. Depending on the orientation of your drive bays, select either Create Vertical
Enclosure or Create Horizontal Enclosure. One of the following enclosure
icons will appear on the screen:

4. Resize the enclosure icon to display the exact number of drive bays you need. To
resize, place the mouse pointer on the bottom-side or right-side of the icon and
press and hold the left mouse button. When the mouse pointer changes to a
double-headed arrow, drag the mouse pointer until the desired number of drive
bays is displayed. As you drag the mouse pointer, the number of drive bays will
change dynamically.

5. Repeat the same procedure for the other drive bays you may still have in your
configuration.

6. To fill in the drive bays in the enclosure just created, display the Physical Drives
window. To display this window, click on the Physical Drives command button
or select the Physical Drives command from the Open menu.

7. From the Physical Drives window, drag the physical drives to their respective
drive bays in the Enclosure window.

8. Check to ensure that all drives are in their respective drive bays. To check, let
the mouse pointer hover over each drive icon. A table will appear displaying
some information about the drive.

NOTE:  If you have placed the wrong drive in a drive bay, just drag over the
correct drive from the Physical Drive window over and drop it into the correct
drive bay.
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Removing a drive bay from an enclosure
1. Double-click on the target drive bay. The following menu will appear on the

screen:

2. Select Remove Bay from Enclosure.

Moving an enclosure
1. Place the mouse pointer on the left-side or top-side of the enclosure icon and

press and hold the left mouse button.

2. Drag the icon to the desired location within the Enclosure window. When you
have reached the target location, release the mouse pointer to drop the enclosure
icon.

Deleting an enclosure
1. Double-click on any area of the enclosure icon, except on occupied drive bays.

The following message will appear on the screen:

2. Click OK to delete the entire enclosure.
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Setting Controller Configuration
The GUI RAID Manager enables you to modify the configuration of the disk array
controller from your manager console. You can enable or disable the write-back
cache of the system, set whether or not the controller will reset the SCSI bus during
power-on, stagger the drives’ motor spin-up sequence, set the baud rate of the
controller’s RS-232 port, and modify the station password.

The following describes the user-configurable parameters:

• Write-Back . This parameter allows you to enable or disable the write-back cache
of the system. The write-back cache allows write data to be stored in the cache
memory prior to writing to the disk, thereby pipelining the I/O write process.

• SCSI Reset on Power-up. This parameter determines whether or not the con-
troller will assert SCSI bus reset during power-on initialization.

• Staggered Drive Spin-Up. This parameter determines whether or not the con-
troller will sequence the drives to start spinning in succession at five-second
intervals. Enabling staggered drive spin-up can help prevent overloading the
power supply when many drives spin up at the same time.

• RS-232 Baud Rate. This parameter sets the baud rate of the RS-232 port on the
controller. When connecting a host computer, terminal, or other device (such as
a modem) onto this port, ensure that their baud rates are set accordingly; other-
wise, there will be communication problems.

• Change Password. This parameter allows you to modify the current password
of the GUI RAID Manager station. This password prevents any unauthorized
modifications on the system configuration. For more information about the sta-
tion password and other security issues, see the Setting Up Security section un-
der “Basic Operations at Startup.”

Setting the controller configuration
1. Display the Physical Drives window by clicking the Physical Device command

button or selecting the Physical Drive command from the Open menu.

2. From the Physical Drives window, double-click the displayed controller (that is,
the card layout for the ASUS PCI-to-SCSI controller). The Controller Settings
dialog box will appear:
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3. From the Write-Back  drop-down list box, select the write-back cache state. To
select, click on the down-arrow button at the right of the box, then select the
option you need. To enable the write-back cache, select Enabled; to disable,
select Disabled.

4. If you want a SCSI bus reset to be issued on the drive channels every time you
power on or reset the disk array system, set the SCSI Reset on Power-Up pa-
rameter to Enabled. Otherwise, set this parameter to Disabled.

5. To avoid overloading the power supply when several drives spin up at the same
time, set the Staggered Drive Spin-Up parameter to Enabled. If a fast system
startup is needed, and the power supply is capable of handling all the power
requirements of the drives at the same time, set this parameter to Disabled.

6. Use the RS-232 Baud Rate drop-down list box to set the baud rate of the RS-
232 port on the controller. If you have a host computer, terminal, or other device
(such as a modem) connected to this port, specify here the baud rate of the con-
nected device, or set the port’s baud rate here and make the baud rate of the
device correspond to this value.

7. If you want to modify the password, check the Change Password check box,
and then specify the new password in the provided text box. You will need to
confirm your password.

8. Click OK to save the new controller configuration. If you specified a new pass-
word, this value will be saved into the non-volatile memory on the disk array
controller.



96 ASUS PCI-DA2100 User’s Manual

Setting Channel Configuration
From within the GUI RAID Manager, you can modify the configuration of any
channel on the controller. You can set the channel operation mode to host or drive,
enable or disable the channel termination, set its SCSI ID, set the transfer clock rate
for synchronous communication, and select the transfer width.

The following describes the user-configurable parameters:

• Channel Mode. This parameter sets the operation mode of a particular channel
on the SCSI-to-SCSI controller. It configures the operation mode to either host
or drive, where a host channel is used when connecting to a host, while a drive
channel is for connecting to SCSI drives. Any SCSI channel on the SCSI-to-
SCSI controller can serve as either a host or a drive channel. Channel 0 is the
default host channel with SCSI ID number 0.

For a PCI-to-SCSI controller, this parameter is permanently set to Drive.

• Termination . This parameter enables or disables SCSI channel termination. SCSI
cables must be properly terminated at both ends; that is, when connecting one
end of a SCSI cable to a channel, the termination of the channel must be en-
abled. Note that the other end of the cable must also be properly terminated.

You can terminate the other end of the cable by installing or enabling termina-
tion on the SCSI drive farthest from the controller or by installing an external
terminator on the end connector. The latter method is recommended so that re-
moval of the drives will not affect cable termination. All other terminators must
be removed or disabled making sure that only one terminator is installed on each
end.

• SCSI ID. This parameter sets the SCSI ID of the channel. Each channel must
have a unique SCSI ID in order to work properly. SCSI ID ranges from 0 up to
15, with 0 assigned as the default value for host channels, and 7 for drive chan-
nels.

• Default Sync Clock (MHz), Default Xfer Width. These parameters set the
data transfer clock rate for synchronous communication over the SCSI bus, and
enable or disable wide transfer, respectively. For a detailed description of these
parameters, see the discussion below.
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Data that is transferred across the SCSI bus in synchronous transfer mode is
clocked using a synchronous transfer clock signal. The frequency of this signal
determines the rate at which data is transferred. If, for example, the synchronous
transfer clock is 10 MHz, data transfer rate will be 10 million bytes per second
(assuming narrow transfer).

Data transfer across the SCSI bus can be either 8 bits or 16 bits at a time. The
former is referred to as narrow” transfer, while the latter is referred to as wide”
transfer. At the same synchronous transfer clock rate , data transfer rate using
wide transfer will be double that using narrow. With synchronous transfer clock
of 10 MHz, data transfer rate will be 10 Mbytes/second under narrow transfer,
and 20Mbytes/second for wide.

Occasionally, under conditions in which SCSI signal quality is poor, such as
long cables, poor connections, or bad termination, it may be necessary to reduce
the synchronous transfer clock to allow the SCSI channel to function normally.
Under worst conditions, it may be necessary to switch to asynchronous commu-
nication mode.

Furthermore, certain older SCSI devices may only support narrow transfer and
behave abnormally when an attempt to negotiate wide transfer is made. Under
such conditions, wide transfer may need to be disabled, forcing the controller to
use narrow transfer mode with that device.

Setting the configuration of a channel
1. Display the Physical Drives window by clicking on the Physical Drives com-

mand button or selecting the Physical Drives command from the Open menu.

2. From the Physical Drives window, double-click on the corresponding SCSI Chan-
nel icon of the target channel. SCSI Channel icons are displayed on the card
layout of a PCI-to-SCSI controller, or just below the front panel of a SCSI-to-
SCSI controller. The Channel Setting dialog box will appear:
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3. If you are using a SCSI-to-SCSI controller, select the channel mode from the
Channel Mode drop-down list box. To select, click on the down-arrow button
at the right of the box, then select the option you want. If you want to configure
the selected channel as a host channel, select Host; to configure as a drive chan-
nel, select Drive.

4. From the Termination  drop-down list box, specify whether to enable the chan-
nel termination or not. To enable, select Enabled; to disable, select Disabled.

5. If you want to assign a different SCSI ID to the selected channel, specify the
new ID in the SCSI ID drop-down list box. When selecting a value, be sure that
it does not conflict with the other SCSI devices on the channel.

6. To change the speed of the SCSI bus synchronous transfer clock, type in the new
value in the Default Sync Clock (MHz) text box.

7. From the Default Xfer Width  drop-down list box, select whether to use narrow
or wide transfer. To use narrow transfer, select Narrow ; to use wide transfer,
select Wide.

8. Click OK to save the new channel configuration into the non-volatile memory
of the controller.

Scanning in Drives
Disk scanning is a process in which a newly installed drive is introduced to the disk
array system. You need to scan in a drive when:

• The drive is a new one. A drive is considered a new drive if it is not yet displayed
in the Physical Drives window.

• The drive is a replacement for a failed drive which is installed on a different
channel or has a different SCSI ID.

If you do not scan in the drive on such occasions, the system will not be able to see
the drive, rendering the drive useless.

Scanning in a drive
1. Display the Physical Drives window by clicking on the Physical Drives com-

mand button or selecting the Physical Drives command from the Open menu.

2. From the Physical Drives window, double-click on the connector corresponding
to the SCSI ID of the drive being scanned. A confirmation message similar to
the following will appear on the screen:
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3. Click OK. The system will scan for a drive with the specified ID and then will
display either a successful message or an error message.

4. Click OK.

The GUI RAID Manager will place a drive icon on the respective connector if
the scanning process is successful.

Creating and Deleting Logical Drives
You can create logical drives by simply combining physical drives together. The
GUI RAID Manager provides you with two options for creating logical drives: au-
tomatic and manual. In the automatic method, the GUI RAID Manager automati-
cally selects all available (that is, unassigned) drives in the system and then recom-
mends the appropriate RAID level. Drives can be manually deselected and/or a dif-
ferent RAID level can be selected if so desired.

In the manual method, you select the drives you want to be included in and the
RAID level of the logical drive. To assist in the selection of the RAID level, the GUI
RAID Manager recommends a RAID level based on the number of drives you have
selected. You can either accept the recommended RAID level or specify the one you
prefer.

The GUI RAID Manager also provides you with the option to delete logical drives.
Before deleting though, be sure that the stored data on the target logical drive is no
longer needed. Deleting a logical drive erases all stored information.

NOTE:  When you delete a logical drive, all assigned physical drives to this
drive will be released, making them available again for logical drive creation.

To create a logical drive
1. Display the Logical Drives window by clicking on the Logical Drives com-

mand button or selecting the Logical Drives command from the Open menu. If
you intend to use the manual method, display also the Physical Drives window
by clicking on the Physical Drives command button or selecting the Physical
Drives command from the same menu.
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2. From the Logical Drives window, double-click on an unused logical drive icon.

-or-

Double-click the right mouse button on an unused logical drive icon and then
select Create from the displayed menu. The Logical Drive Creation dialog box
will appear:

3. If you want to use the automatic method, check the Auto Drive Selection check
box and then proceed to step 8.

4. If you want to use the manual method, uncheck the Auto Drive Selection check
box.

5. From the Physical Drives window, click on the target drives. Be sure to select
only unassigned drives (those that appear in gray). The Number of Drives Se-
lected field displays the number of selected drives.

6. If you want to modify the recommended RAID level, specify the level you pre-
fer in the RAID Level drop-down list box. To select, click on the down-arrow
button at the right of this box and then select the option you want. The 1+Spare,
3+Spare, and 5+Spare options are RAID 1, RAID 3, and RAID 5 levels respec-
tively, each with a spare drive. For information on the various RAID levels, see
the appendices for the “ RAID Levels.”
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7. The value in the Max Drive Capacity (MB) text box determines how much
capacity from each drive will be used in the logical drive. It may be useful to
utilize this parameter to restrict capacity when the possibility exists that replace-
ment drives acquired in the future might have slightly less capacity than the
drives to be included in the logical drive. Type in the desired capacity in this
box.

8. Click OK.

To delete a logical drive
1. Display the Logical Drives window by clicking on the Logical Drives com-

mand button or selecting the Logical Drives command from the Open menu.

2. From the Logical Drives window, double-click the right mouse button on the
target logical drive. The following menu will appear on the screen:

3. Select Delete.

Assigning Spare Drives
You can assign spare drives to a logical drive to serve as backups for failed drives. In
the event of a drive failure, the spare drive will be automatically configured into the
array and reconstruction (or rebuilding) will immediately commence.

Logical drives can support multiple spare drives; this configuration however is rarely
used due to its high cost and uncommon occurrences of drive failures. A practical
configuration calls for one spare drive per logical drive - after rebuilding on this
drive, just replace the failed drive and then configure the replacement as the new
spare drive of the logical drive.
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NOTE:  Adding a spare drive can be done automatically by selecting the 1+Spare,
3+Spare or 5+Spare option from the Logical Drive Selection dialog box when
creating a logical drive. These options however only apply to RAID 1, RAID 3,
and RAID 5 levels respectively.

Assigning a spare drive
1. Display the Physical Drives and Logical Drives windows. To display the former,

click on the Physical Drives command button or select the Physical Drives
command from the Open menu. To display the Logical Drives window, click on
the Logical Drives command button or select the Logical Drives command
from the same menu.

2. From the Physical Drives window, position the mouse pointer on the icon of the
drive you wish to be the spare drive and press and hold the left mouse button.

3. Drag the drive icon over to the destination logical drive and then release the
mouse button. The following message will appear on the screen:

4. Click OK.

Rebuilding Logical Drives
Depending on whether or not there is a spare drive, rebuilding is initiated automati-
cally or manually. In the presence of a spare drive, the system automatically re-
builds onto the spare drive. This process is done in the background, thus it appears
transparent to the user.

In the absence of a spare drive, rebuilding must be initiated manually. Before initiat-
ing a manual rebuild, you need to first replace the failed drive. If you install the
replacement drive on the same connector (that is, same channel and SCSI ID), then
you can proceed with the rebuilding process; otherwise, you need to scan in the
drive first.
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To rebuild a logical drive
1. Display the Logical Drives window by clicking on the Logical Drives com-

mand button or selecting the Logical Drives command from the Open menu.

2. From the Logical Drives window, double-click the right mouse button on the
degraded logical drive. The following menu will appear on the screen:

3. Select Rebuild.

Creating and Deleting Logical Volumes
You can create and delete logical volumes from your GUI RAID Manager station.
Logical volumes are created by simply combining unassigned logical drives together.
You can combine logical drives with different capacities and RAID levels into one
logical volume. Alternatively, you can delete existing logical volumes. Before delet-
ing though, be sure that the data stored in the logical volume is no longer needed.
Deleting a logical volume erases all stored information.

NOTE:  When you delete a logical volume, all assigned logical drives to this vol-
ume will be released, making them available again for logical volume creation.

To create a logical volume
1. Display the Logical Drives and Volume windows. To display the former, click

on the Logical Drives command button or select the Logical Drives command
from the Open menu. To display the Volume window, click on the Logical Vol-
ume command button or select the Logical Volume command from the same
menu.

2. From the Logical Drives window, position the mouse pointer on the icon of a
logical drive you wish to include in creating the logical volume and press and
hold the left mouse button.
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3. Drag the icon over to the target logical volume and then release the mouse but-
ton.

4. Repeat steps 2–3 for the remaining logical drives you want to include in the
logical volume.

5. Double-click the right mouse button on the target logical volume. The following
menu will appear:

 6. Select Volume. Then, from the next menu, select Create LV.

The logical volume is now created. You may now define its partitions. See Creating
and Deleting Partitions on the following page.

To delete a logical volume
1. Display the Volume window by clicking on the Logical Volume command but-

ton or selecting the Logical Volume command from the Open menu.

2. Double-click the right mouse button on the target logical volume. The following
menu will appear:

3. Select Volume. Then, from the next menu, select Delete LV.
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Creating and Deleting Partitions
Depending on your specific needs, you can either partition a logical volume into
smaller sizes or just leave it at its default size (that is, one large partition covering
the entire volume). If you intend to map the entire logical volume to a single host
LUN, then partitioning becomes irrelevant; however, if the volume is to be mapped
to multiple host LUNs, then you need to define partitions for later mapping to spe-
cific LUNs.

NOTE:  You can create a maximum of eight partitions per logical volume.

Creating partitions for a logical volume
1. Display the Volume window by clicking on the Logical Volume command but-

ton or selecting the Logical Volume command from the Open menu.

2. Double-click the right mouse button on the target logical volume. The following
menu will appear:

3. Select Partition . The following menu will appear on the screen:

4. Select Create Partition. A table similar to the following will appear displaying
the current partition layout:
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5. Adjust the partition size using the vertical scroll bar on the displayed table. Click
OK when the desired size is achieved.

You can also adjust the partition size by placing the mouse pointer on the logical
volume icon and then moving the displayed dotted line. As you move the line,
the partition size changes accordingly. The table reflects the changes on the size
of the affected partition. Click the mouse button when the desired size is reached
or move the mouse pointer over to the vertical scroll bar for micro adjustment
then click OK.

6. If you wish to create a subpartition for an already existing partition, double-
click the right mouse button anywhere within its area. Then, repeat steps 3–5.

 You can create up to eight partitions per logical volume.

7. After defining the desired partitions, double-click the right mouse button on the
current logical volume.

8. From the displayed menu, select Partition . Then, select Set Partition.

The logical volume is now ready for mapping to host LUNs. See Mapping Logical
Volumes/Partitions to Host LUNs later in this section.

Deleting logical volume partitions
1. Display the Volume window by clicking on the Logical Volume command but-

ton or selecting the Logical Volume command from the Open menu.

2. Double-click on the partition you wish to delete. The following menu appears
on the screen:
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3. Select Partition . The following menu will appear on the screen:

4. Select Delete Partition.

5. Repeat the same procedure to delete the other unwanted partitions.

6. After deleting partitions, double-click the right mouse button on the current logical
volume.

7. From the displayed menu, select Partition . Then, select Set Partition.
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Mapping Logical Volumes/Partitions to Host LUNs
After creating a logical volume, you can map it as is to a host LUN if you prefer; or,
if partitions are set, you can map each partition to specific host LUNs. Each host
supports eight LUNs, each of which appears as a single drive letter to the host if
mapped to a logical volume (or its partition).

Alternatively, you can delete existing host LUN mappings. In cases where certain
mappings are found useless, or disk array reconfiguration is needed, you can delete
unwanted mappings in your system.

Mapping an entire logical volume to a host LUN
1. Display the Volume and Host LUN Assignment windows. To display the former,

click on the Logical Volume command button or select the Logical Volume
command from the Open menu. To display the Host LUN Assignment window,
click on the Host LUN Assignment command button or select the Host LUN
Assignment command from the same menu.

2. From the Volume window, position the mouse pointer on the icon of the logical
volume you wish to map and press and hold the left mouse button.

3. Drag the icon over to the target host LUN and then release the mouse button.

Mapping logical volume partitions to host LUNs
1. Display the Volume and Host LUN Assignment windows. To display the former,

click on the Logical Volume command button or select the Logical Volume
command from the Open menu. To display the Host LUN Assignment window,
click on the Host LUN Assignment command button or select the Host LUN
Assignment command from the same menu.

2. From the Volume window, position the mouse pointer on the partition you wish
to map and press and hold down the left mouse button.

3. Drag the partition over to the target host LUN and then release the mouse but-
ton.

4. Repeat the same procedure for the other remaining partitions on the logical vol-
ume to be mapped.

Deleting a host LUN mapping
1. Display the Host LUN Assignment window by clicking on the Host LUN As-

signment command button or selecting the Host LUN Assignment command
from the Open menu.
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2. From the Host LUN Assignment window, double-click on the icon of the mapped
logical volume. The following confirmation message appears on the screen:

3. Click OK.

Displaying the Event Log
The GUI RAID Manager keeps a log file for documenting all events that occurred in
the disk array system ranging from simple notifications, to warnings, to alerts.

The GUI RAID Manager saves the system log into a file named EVENT.LOG in the
GUI RAID Manager directory. You can view the contents of this text file using any
text editor program such as Windows Notepad. You can also print out the contents of
the log file on a printer for reference purposes. In the event of a system failure, you
can use the print-outs for diagnosis.

To display the event log
1. Click on the Event Log command button or select the Event Log command

from the Open menu. The Event Log window will appear:
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The events in the window are sorted according to the date and time they oc-
curred. Description for each event is also provided to facilitate reference.

2. To scroll through the list, use the vertical scroll bars.

Monitoring Statistics
The GUI RAID Manager comes with a statistics monitoring feature to report on the
overall performance of the disk array system. This feature provides a real-time re-
port on the current throughput of the system, displaying the number of bytes being
read and written per second. These values are displayed in a graphical format to
facilitate reference.

To monitor the current data traffic on the disk array system
• Click on the Statistics command button or select the Statistics command from

the Open menu. The Statistics window appears:

The Statistics window displays the amount of data being read from and written
to the disk array system, in MB per second. Read values appear in green, and are
displayed under Write values which appear in red.

NOTE:  The program automatically adjusts the y-axis to fit the entire graph
snugly in the Statistics window.
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Notification Configuration

A management program is almost useless without reporting or notification function
ability. For this reason, the GUI RAID Manager enables you to configure notifica-
tions to occur in response to various disk array events. For example, if you configure
an e-mail notification, the GUI RAID Manager will send an e-mail to selected com-
puters on the network if the event (that just occurred) falls within the selected noti-
fication level. If the notification is detailed enough, the recipient can respond ac-
cordingly.

The notification function makes it possible to manage (or monitor) the disk array
system even when the administrator is away from the manager station. When prop-
erly configured, this function can notify the administrator of event occurrences in the
managed disk array system instantly even when he or she is at home, or in other
places around the globe.

The GUI RAID Manager provides four methods of sending notifications:

• Pager

• Fax

• E-mail

• Broadcast

You can use any of the notification methods mentioned above; be reminded though
that before you can use a particular method, you should have the proper hardware
(like a modem for the pager notification) and software (like Windows NT for the
broadcast message notification) installed in your system.

Notification Levels
The GUI RAID Manager classifies disk array events into three levels depending on
their severity. These include Level 1, Level 2, and Level 3. The first event level
covers notificational events such as initialization of the controller and initiation of
the rebuilding process; Level 2 includes events which require the issuance of warn-
ing messages; Level 3 is the highest level, and covers events the need immediate
attention (and action) from the administrator. The following lists sample events for
each level:
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Level 1 Sample Events
• Controller Initialization Complete

• Rebuild Initiated

• Rebuild Complete

• Rebuild Failed

• Logical Drive Initialization Started

• Logical Drive Initialization Complete

• Logical Drive Initialization Failed

Level 2 Sample Events
• SCSI Target Select Timeout

• SCSI Target Phase/Signal Error

• SCSI Target Unexpected Disconnect

• SCSI Target Negotiation Error

• SCSI Target Timed Out

• SCSI Target Parity Error

• SCSI Bus Reset Issued

• SCSI Target Not Ready Error

• SCSI Target Media Error

• SCSI Target Hardware Error

• SCSI Target Unit Attention

• SCSI Target Unexpected Sense Date

• SCSI Target Block Reassignment Failure

• SCSI Target Unexpected Data Over/Underrun

• Drive SCSI Unrecognized Event
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Level 3 Sample Events
• SCSI Drive Failure

You select the notification level from the RAID Manager Options dialog box. Se-
lecting a relatively low level also selects the level(s) above it; thus, selecting Level
1 events, for example, will also select Levels 2 and 3 events. Since Level 3 is the
highest level, selecting this will only select Level 3 events.

Configuring Notification Options
The RAID Manager Options dialog box allows you to enable or disable the notifica-
tion function of the GUI RAID Manager, select the notification level, specify the
event countdown limit, and stop all on-going pager notifications. Event countdown
is the latency time between event occurrence and notification sequence initiation;
this helps administrators to abort issuance of the notification sequence should they
be on-site already.

To configure notification options
1. Select Options from the menu bar. The RAID Manager Options dialog box appears:

2. To enable the notification function of the GUI RAID Manager, select the En-
able option button in the Event Notification field. To disable, select the Dis-
able option button.
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3. From the RAID Event Level drop-down list box, select the notification level.
To select, click on the down-arrow button at the right of this box, then select the
option you want. The All Events option includes Levels 1, 2, and 3 events;
Warning  covers Levels 2 and 3 events; Alert  covers Level 3 events. Default
notification level is Alert .

4. In the Event Countdown Limit  text box, type in the latency time you need.
This determines how long to wait after the occurrence of the event before actu-
ally sending the configured notification.

5. To stop all on-going pager notifications, check the Stop All In-Progress Event
Notification  check box. Since the pager notification function repeatedly sends
the notification at a user-configurable time interval, you can stop subsequent
transmissions with this check box. Be reminded though that this will only affect
the current event; for succeeding events, this check box will revert to its default
state of disabled (no check mark).

You can also stop the on-going pager notification to a specific recipient through
the Personal Information: Pager dialog box. For information, see the Configur-
ing a Pager Notification section.

6. Click OK to save the new notification option settings.

Configuring a Pager Notification
You can configure a pager notification that will send a message to a paging device
when a specific disk array event occurs in the system.

It is recommended that a unique number be assigned to identify a specific disk array
system. Since messages received on a pager may vary widely, you need to assign a
number to facilitate reference. For example, if the disk array system in the Account-
ing Department of your company has 01131965 assigned to it, when this number is
sent to the pager, the recipient knows that the message is from the disk array system
in the Accounting Department.

For pager notification to work, you should have a modem connected to the RS-232 of
your manager station. This modem should then be connected to a working telephone
line. The communication parameters of both the modem and the RS-232 port on the
computer should be set accordingly.

Modem Settings
The modem plays a vital role in the pager notification function for it acts as the
medium between the manager station and the outside world. If not configured or
installed properly, this method of notification will not work properly, preventing
communication with any paging device.
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To configure the connected modem

1. From the Notification  menu, select Pager → Settings.

-or-

Click on the Notification  command button and then select Pager → Settings.
The Settings for Modem dialog box appears:

2. In the COM Port # drop-down list box, select the COM port where you in-
stalled the modem. To select, click on the down-arrow button at the right of this
box. Then, select the port you need.

3. In the Baud Rate drop-down list box, select the baud rate of the connected
modem. Be sure to select the correct value here; otherwise, the modem will not
work properly. To select, click on the down-arrow button and then select the
value you need.

4. In the Parity , Data Bits, and Stop Bits drop-down list boxes, set the other per-
tinent communication parameters. Be sure that the values you specify corre-
spond to the actual settings on the modem. By default, these parameters are set
to no parity, 8 data bits, and 1 stop bit.

5. In the Modem Settings field, specify the modem reset and initial strings. These
values vary with the type of modem you are using. For information about these
parameters, check the documentation that came with your modem.

6. If you want to check to be sure the settings are correct, click on the Test button.
If you receive a successful message, it means that the settings are correct and
link with the modem is okay. If you receive an error message, check if the set-
tings correspond to those assigned to the modem, or check the cable connecting
the modem to your computer. Check also if the modem is turned on.

7. If everything is correct, click OK to save the settings.



116 ASUS PCI-DA2100 User’s Manual

III. GUI RAID MANAGER

III. G
UI

Notification Configuration

Selecting the Destinations
You can configure the pager notification function to send a notification to multiple
pagers. This is achieved through the pager address book provided by the GUI RAID
Manager. From this book, you can add and remove entries, and select which of these
entries will receive notification from the system.

To maintain the pager address book

1. From the Notification  menu, select Pager → Address Book.

-or-

Click on the Notification  command button and then select Pager → Address
Book. The Address Book for Pager Notification dialog box appears:

The list box on the left of this dialog box displays the current contents of the pager
address book.

2. Click on the Add button to add a new entry. The Personal Information: Pager
dialog box appears:

3. In the Full Name text box, type in the name of the notification recipient. This
only serves for reference purposes in the address book.
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4. Enter the pager number in the Pager Number text box, including the area code.
If you want to add a delay between the sending of this number and the sending
of the actual message, add commas at the end of the pager number. The more
commas you add, the longer the delay is. You can also add commas in front of
the message.

5. Type in the appropriate message in the Message text box. If you want to add a
delay between the sending of the pager number and the sending of this message,
add commas in front of this value. The more commas you add, the longer the
delay is. You can also add commas at the end of the pager number.

6. To enable pager notification for this particular entry, select the Enable option
button. To disable, select the Disable option button.

7. If you want to check the reachability of the specified destination, click on the
Test button. Then, check whether or not the notification is received successfully
on the pager.

8. Click OK to add the specified destination to the address book.

9. Repeat the same procedure to add the other entries you want.

10. If you want to delete an entry from the address book, select it from the list box
and then click on the Remove button.

11. If you want to modify the settings of a particular entry, select it and then click on
the Properties button. From the displayed dialog box, modify the parameters
you want.

Prescheduling Pager Notification
You can preschedule the pager notification for a particular destination to occur auto-
matically at specific intervals. This notification will be sent regardless of the events
occurring in the disk array system.

NOTE:  The prescheduled pager notification does not affect in any way the con-
figured pager notification — prescheduled pager notification is triggered by time,
while configured pager notification is triggered by events based on the selected
notification level.

To preschedule a pager notification

1. From the Notification  menu, select Pager → Address Book.

-or-

Click on the Notification  command button and then select Pager → Address
Book. The Address Book for Pager Notification dialog box appears:
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The list box on the left of this dialog box displays the current contents of the
pager address book.

2. From the list box, select the target entry, then click on the Properties button.
The Personal Information: Pager dialog box appears:

3. Click on the Period button. The Scheduled Period for Calling Pager dialog box
appears:
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4. In the From and To text boxes, specify the time ranges you want.

5. For each time range, specify the notification frequency in the respective Period
(Min)  text box. For example, if you want to send a notification to the selected
destination every hour from 1:00 AM up to 5:00 AM, set From and To to 0100
and 0500, respectively, and Period (Min)  to 60.

6. Click OK.

Stopping On-going Pager Notification
Once initiated, the pager notification function will repeatedly send the notification
to the destination pagers at a specific time interval. You have the option though to
stop subsequent retransmissions for a particular destination, or for all destinations.

To stop any on-going pager notification to a particular destination

1. From the list box in the Address Book for Pager Notification dialog box, select
the target entry, then click on the Properties button. The Personal Information:
Pager dialog box appears displaying the current settings of the selected entry:

To determine if there is any on-going pager notification on the selected pager,
check the Error Recovery Status field. If this field displays Active, it means
that there is; if this displays Stand-by, it means that there is none.

2. If there is on-going pager notification and you want to stop subsequent retrans-
missions, check the Stop In-Progress Event Notification check box.

3. Click OK.

You can also stop on-going pager notification for all destination pagers through the
RAID Manager Options dialog box. For information about this feature, see “Con-
figuring Notification Options” previously discussed in this section.
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Configuring a Fax Notification
The GUI RAID Manager sends fax messages to specific destinations using the Mi-
crosoft Fax Exchange service. If your manager station does not have this service,
install it first before using the fax notification function of the system. You will also
need to connect a fax/modem to your computer. Installing a fax/modem can be a
tricky process, so consult your operating system manuals for instructions on how to
install your fax/modem software.

Since the GUI RAID Manager depends largely on Microsoft Fax Exchange for the
delivery of fax messages, most fax notification parameters are configured through
this software package. The GUI RAID Manager only allows you to select which
users will receive the notification messages, and specify the notification message for
each recipient.

For information on how to configure users for fax reception and other pertinent
information about the Microsoft Fax Exchange, refer to the Microsoft Fax Exchange
manual. Ensure that the Fax Exchange service is properly configured in your com-
puter before using the fax notification function of the GUI RAID Manager.

Selecting the Destinations
You can configure the fax notification function to send a notification to multiple
users. This is achieved through the fax address book provided by the GUI RAID
Manager. From this book, you can add and remove entries, and select which of these
entries will receive notification from the system.

 To maintain the fax address book

1. From the Notification  menu, select Fax → Address Book.

-or-

Click on the Notification  command button and then select Fax → Address
Book. The Address Book for Fax Notification dialog box appears:
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The list box on the left of this dialog box displays the current contents of the fax
address book.

2. Click on the Add button to add a new entry. The Personal Information: Fax
dialog box appears:

3. In the Display Name text box, type in the name of the user that will receive a fax
notification. If you specify a name that does not have an account on Fax Ex-
change yet, the program will prompt you to create one for this particular user.

4. In the Message text box, specify the fax message you want to relay to the se-
lected user.

5. To enable fax notification for this particular entry, select the Enable option but-
ton. To disable, select the Disable option button.

6. If you want to check the reachability of the selected user, click on the Test but-
ton.

7. Click OK to add the specified entry to the address book. The Choose Profile
dialog box appears on the screen.

8. To accept the MS Fax Exchange default setting, click OK. To choose another
profile, click the New button. For assistance on how to proceed from here, refer
to your Windows manual.

9. Repeat the same procedure to add the other entries you want.

10. If you want to delete an entry from the address book, select it from the list box
and then click on the Remove button.

11. If you want to modify the settings of a particular entry, select it and then click on
the Properties button. From the displayed dialog box, modify the parameters
you want.

12. To put the Fax notification function into effect, start the MS Fax Exchange.
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Configuring an E-Mail Notification
The GUI RAID Manager sends e-mail messages to specific people on the network
or Internet using the Microsoft Mail and/or Microsoft Internet Mail services in Mi-
crosoft Exchange. You will need these services to enable the e-mail notification
function of the GUI RAID Manager. In addition to this, you will also need a network
interface card or modem to connect your manager station to the network or Internet.

Since the GUI RAID Manager depends largely on services mentioned above for the
delivery of e-mail messages, most e-mail notification parameters are configured
through these packages. The GUI RAID Manager only allows you to select the users
who will receive the notification messages, and specify the notification message for
each recipient.

For information on how to configure users for e-mail reception and other pertinent
information about the Microsoft Mail and Microsoft Internet Mail services in Mi-
crosoft Exchange, refer to the Microsoft Exchange manual. Be sure that these ser-
vices are configured properly, and functioning before using the e-mail notification
function of the GUI RAID Manager.

Selecting the Destinations
You can configure the e-mail notification function to send a notification to multiple
users. This is achieved through the e-mail address book provided by the GUI RAID
Manager. From this book, you can add and remove entries, and select which of these
entries will receive notification from the system.

To maintain the e-mail address book

1. From the Notification  menu, select E-mail → Address Book.

-or-

Click on the Notification  command button and then select E-mail → Address
Book. The Address Book for E-mail Notification dialog box appears:

The list box displays the current contents of the e-mail address book.
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2. Click on the Add button to add a new entry. The Personal Information: E-mail
dialog box appears:

3. In the Display Name text box, type in the name of the user that will receive an
e-mail notification. If you specify a name that does not have a network account
yet, Exchange will prompt you to create one for this particular user.

4. In the Message text box, specify the message you want to send to the selected
user.

5. To enable e-mail notification for this particular entry, select the Enable option
button. To disable, select the Disable option button.

6. If you want to check the reachability of the selected user, click on the Test but-
ton.

7. Click OK to add the specified entry to the address book. The Choose Profile
dialog box appears on the screen.

8. To accept the MS Exchange default setting, click OK. To choose another profile,
click the New button. For assistance on how to proceed from here, refer to your
Windows manual.

9. Repeat the same procedure to add the other entries you want.

10. If you want to delete an entry from the address book, select it from the list box
and then click on the Remove button.

11. If you want to modify the settings of a particular entry, select it and then click on
the Properties button. From the displayed dialog box, modify the parameters
you want.

12. To put the E-mail notification function into effect, start the Microsoft Messag-
ing (Exchange).
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Configuring a Broadcast Message Notification
The GUI RAID Manager provides a way to notify selected users on the network by
sending broadcast messages to their respective stations. This notification method
only works on Windows NT stations with the Windows NT Messenger service in-
stalled. If your system does not have these programs, you will not be able to use this
method. In addition to these programs, your station also needs a network interface
card to connect to an existing network. Be sure that the adapter is properly installed
and configured, and the correct driver is used.

For information on how to configure users for broadcast message reception in Win-
dows NT and other pertinent information about this software, refer to the Windows
NT manual.

Selecting the Destinations
You can configure the broadcast message notification function to send messages to
multiple users. This is achieved through the broadcast message address book pro-
vided by the GUI RAID Manager. From this book, you can add and remove entries,
and select which of these entries will receive notification from the system.

To maintain the broadcast message address book

1. From the Notification  menu, select Broadcast → Address Book.

-or-

Click on the Notification  command button and then select Broadcast → Ad-
dress Book. The Address Book for Messenger Information dialog box will ap-
pear:

The list box on the left of this dialog box displays the current contents of the
broadcast message address book.

2. Click on the Add button to add a new entry. The Personal Information: Broad-
cast dialog box will appear:
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3. In the Computer Name text box, type in the name of the computer that will
receive a broadcast message. Be sure that the name you specify has a network
account with Windows NT.

4. In the Message text box, specify the message you want to send to the selected
computer.

5. To enable broadcast message notification for this particular entry, select the En-
able option button. To disable, select the Disable option button.

6. If you want to check the reachability of the selected computer, click on the Test
button.

7. Click OK to add the specified entry to the address book.

8. Repeat the same procedure to add the other entries you want.

9. If you want to delete an entry from the address book, select it from the list box
and then click on the Remove button.

10. If you want to modify the settings of a particular entry, select it and then click on
the Properties button. From the displayed dialog box, modify the parameters
you want.
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Prescheduling Broadcast Message Notification
You can preschedule the broadcast message notification for a particular destination
to occur automatically at specific intervals. This notification will be sent regardless
of the events occurring in the disk array system.

NOTE: The prescheduled broadcast message notification does not affect in any
way the configured broadcast message notification — prescheduled broadcast
message notification is triggered by time, while configured broadcast message
notification is triggered by events based on the selected notification level.

To preschedule a broadcast message notification

1. From the Notification  menu, select Broadcast → Address Book.

-or-

Click on the Notification  command button and then select Broadcast → Ad-
dress Book. The Address Book for Messenger Information dialog box appears:

The list box on the left of this dialog box displays the current contents of the
broadcast message address book.

2. From the list box, select the target entry, then click on the Properties button.
The Personal Information: Broadcast dialog box appears:
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3. Click on the Period button. The Scheduled Period for Broadcast dialog box
appears:

4. In the From and To text boxes, specify the time ranges you want.

5. For each time range, specify the notification frequency in the respective Period
(Min)  text box. For example, if you want to send a notification to the selected
destination every hour from 1:00 AM up to 5:00 AM, set From and To to 0100
and 0500, respectively, and Period (Min)  to 60.

6. Click OK.
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Stopping On-going Broadcast Notification
The broadcast message notification function automatically retransmits the message
to a destination computer until an ACK (acknowledgment) message is received from
it. This ensures message reception by the intended administrator. If, however, the
destination computer is off-line, you can terminate subsequent message retransmis-
sions to cut back in the processing time of your computer, and also to lessen traffic
on the network.

To stop message retransmission to a particular destination

1. From the list box in the Address Book for Messenger Information dialog box,
select the target entry, then click on the Properties button. The Personal Infor-
mation: Broadcast dialog box appears displaying the current settings of the se-
lected entry:

To determine if there is any on-going broadcast message notification to the se-
lected computer, check the Error Recovery Status field. If this field displays
Active, it means that there is; if this displays Stand-by, it means that there is
none.

2. If there is on-going broadcast message notification and you want to stop subse-
quent retransmissions, check the Stop In-Progress Event Notification check
box.

3. Click OK.
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Running in Demo Mode

The GUI RAID Manager provides a Demo program for use as a learning tool and
for demonstration purposes.  This program allows you to experiment with various
disk array configurations and check how the system responds and operates under
various conditions.

The Demo program supports all management functions available in the actual GUI
RAID Manager, making management of the virtual disk array system as real as pos-
sible.  You can select the controller for your virtual system and drive channels, the
number of physical drives, configure your logical drives and volumes, partition logical
volumes, and map partitions to hosts.  You can even fail drives to check how the
particular system configuration reacts under such a condition.

Starting the Demo Program
You can use the Demo program any time, even without a real disk array system (that
is, a controller and SCSI drives) installed in your computer.  Since the Demo pro-
gram only simulates management of a disk array system, you will not need any of
these devices.

To Start the Demo Program
1. Start the GUI RAID Manager by performing the appropriate startup procedure

described in the Starting the GUI RAID Manager section of “Basic Operations
at Startup.”

2. From the File menu, select Connect.

-or-

Click on the Connect command button.  The following submenu appears on the
screen:
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3. Select Demo Mode.  The Demo Configuration Options dialog box appears:

4. In the Controller Type  section, select the Host Adapter option button for the
ASUS PCI-DA2100 RAID controller.

NOTE:  The ASUS PCI-DA2100 does not support the “Target Controller” op-
tion because it does not support the SCSI-to-SCSI controller function.

5. From the Channel Count drop-down list box, select the total number of chan-
nels you want to assign to the selected controller.  To select, click on the down-
arrow button at the right of the box.  Then, select the option you want from the
displayed list.  Maximum setting for each controller is eight.

As you select a value, the program enables the corresponding number of Chan-
nel x Mode (where x is the channel number) sections below.

6. If you selected Host Adapter in step 4, proceed to the next step; otherwise,
select the channel mode for each enabled Channel x Mode section.  To config-
ure the channel as a host channel, select the Host option button; to configure it
as a drive channel, select Drive.

7. Click OK.

The Demo program creates a virtual disk array system based on the configuration
specified in the Demo Configuration Options dialog box.  For each drive channel,
the program places four SCSI drives, which you can increase if you want by simply
scanning in drives from unoccupied connectors.

You may now start managing the selected disk array system using the available
commands.  Try experimenting on various commands to see how the system reacts,
and also to help clarify the use of such commands.  All disk array icons on the screen
respond accordingly - just like a real system.  For information on disk array manage-
ment, see Array Management.



ASUS PCI-DA2100 User’s Manual 131

III. GUI RAID MANAGER

III
.G

UI
D

em
o 

M
od

e

NOTE:   The management operations you perform and settings you specify in
Demo mode do not have any effect on the actual disk array system installed in
your computer, assuming you have one installed.  Everything you do under the
Demo mode is only a simulation.

Failing a Drive
The Demo program comes with a Fail One Drive function that allows you to fail a
drive (that is, one physical drive) from any existing logical drives in the system.  This
function is particularly useful in testing the response of the selected disk array sys-
tem when there is failure in one of its drives.

During a drive failure, the system responds differently depending on the current
array configuration.  The following describes the possible scenarios:

¥ If there is a spare drive assigned to the selected logical drive, the virtual control-
ler will automatically start data rebuilding in the background onto the spare
drive.

¥ If there is no spare drive assigned to the selected logical drive, the failed drive
must be replaced and rebuilding must be initiated manually.  If the replacement
drive is installed on a different connector, you will need to scan in first the drive
and assign it as a spare drive for the affected logical drive before rebuilding can
be initiated.

While the logical drive is being rebuilt, its respective icon on the Logical Drives
window reflects the rebuilding status.  The Physical Drives window also reflects the
rebuilding status through the assigned spare drive.

To fail a drive
1. Display the Logical Drives window by clicking on the Logical Drives com-

mand button or selecting the Logical Drives command from the Open menu.

2. From the Logical Drives window, double-click the right mouse button on the
target logical drive.  The following menu will appear on the screen:
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3. Select Fail One Drive.

The Demo program fails one of the drives belonging to the selected logical drive.
The Physical Drives window, and the Enclosure window if implemented, displays
which drive has failed.  The Logical Drives window displays the selected logical
drive in degraded mode.

The system will then react to this situation based on its current configuration; that is,
whether or not a spare drive exists.  For information, see the discussion earlier in this
section.

If you want to fail drives from other existing logical drives, follow the same proce-
dure.

Exiting the Demo Program
If you are done with the Demo program and you want to manage the real disk array
system installed in your computer, quit from the Demo program and then connect to
your disk array system.  Quitting from the Demo program only requires disconnect-
ing from it.

Exiting from the Demo program
¥ From the File menu, select Disconnect.

All toolbar buttons, except the Connect and Notification  command buttons, turn
gray signifying termination of the Demo program.
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Appendix A

Command Summary
This appendix describes the available commands in the GUI RAID Manager disk
array management program.  These commands are presented either in menus or
command buttons.

Menu Commands
This section lists and explains in tabular form the commands available from the
menus in the menu bar.  Keyboard strokes for commands that can also be executed
from the keyboard are indicated in the tables inside angle brackets.  For example:

Connect <C>

means that you can connect to a disk array system by selecting Connect from the
File menu or by pressing the C key on your keyboard.

File Menu Commands

Command Description

Connect  <C> Connects the GUI RAID Manager station to a
particular disk array system for management.
This command has the same function as the
Connect/Open command button found on the
toolbar.

Disconnect  <D> Disconnects from the current disk array system,
terminating the current management session
with the device.

Exit  <X> Exits the GUI RAID Manager.
Open Menu Commands

Command Description

Enclosure  <E> Displays the Enclosure window.  This command
has the same function as the Enclosure
command button found on the toolbar.

Physical Drive  <P> Displays the Physical Drives window.  This
command has the same function as the
Physical Drives command button found on the
toolbar.
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Logical Drive  <L> Displays the Logical Drives window.  This
command has the same function as the
Logical Drives command button found on the
toolbar.

Logical Volume  <V> Displays the Volume window.  This command
has the same function as the Logical Volume
command button found on the toolbar.

Host LUN Assignment  <H> Displays the Host LUN Assignment window.

This command has the same function as the
Host LUN Assignment command button found
on the toolbar.

Event Log  <L> Displays the Event Log window.  This command
has the same function as the Event Log
command button found on the toolbar.

Statistics  <S> Displays the Statistics window.  This command
has the same function as the Statistics
command button found on the toolbar.

View Menu Commands

Command Description

Toolbar  <T> Toggles between displaying and hiding the
toolbar.  To display the toolbar, select this option
until a check mark “Ö“ appears next to it; to hide,
remove the displayed check mark.

StatusBar  <S> Toggles between displaying and hiding the
status bar.  To display the status bar, select this
option until a check mark “Ö“ appears next to it;
to hide, remove the displayed check mark.

Window Menu Commands

Command Description

Tile In-Sequence  <S> A command specifically designed for disk array
management.  This command arranges the
displayed windows horizontally based on their
uses, with each window reduced to fit all
elements within its width.  Has the same
function as the Tile In-Sequence command button
found on the toolbar.
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Cascade  <C> A standard Windows command that
cascades windows in such a way that
they overlap with each other, making their
title bars visible.

Tile Horizontal  <H> A standard Windows command that arranges
windows into smaller sizes, fitting them
horizontally next to each other.

Tile Vertical  <V> A standard Windows command that arranges
windows into smaller sizes, fitting them vertically
next to each other.

Notification Menu Commands

Command Description

Pager  <P> Configures pager notification.

Fax  <F> Configures fax notification.

E-Mail  <E> Configures e-mail notification.

Broadcast  <B> Configures broadcast notification.
Options Command

Command Description

Options This command allows you to configure
the system notification function. From
this command, you can enable or disable
the notification function, select the event
severity, specify the event countdown limit,
and stop all on-going pager notifications.

Help Menu Commands

Command Description

Contents Displays the GUI RAID Manager on-line help
manual.

About RAID Manager Displays some information about the GUI
RAID Manager program.
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Command Buttons
This section describes the various command buttons provided by the system to fa-
cilitate execution of commonly used commands.  These buttons can be found on the
toolbar.

Command Button Description

Connect/Open Connects your GUI RAID Manager station
to a particular disk array system for
management.  Has the same function as
the Connect command in the File menu.

After connection to a disk array system has
been established successfully, this button
becomes the Open button, providing the
same function as Open in the menu bar.

Tile In-Sequence A command button specifically designed for
disk array management.

This button arranges the displayed windows
horizontally based on their uses, with each
window reduced to fit all elements within its
width.  Has the same function as the Tile In-
Sequence command found in the Window menu.

Enclosure Displays the Enclosure window.  This button
has the same function as the Enclosure
command in the Open menu.

Physical Drives Displays the Physical Drives window.  Has the
same function as the Physical Drive command
found in the Open menu.
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Logical Drives Displays the Logical Drives window.  Has the
same function as the Logical Drive command
found in the Open menu.

Logical Volume Displays the Volume window.  This button has
the same function as the Logical Volume
command in the Open menu.

Host LUN Assignment Displays the Host LUN Assignment window.
Has the same function as the Host LUN
Assignment command found in the Open menu.

Event Log Displays the Event Log window.  This button
has the same function as the Event Log
command found in the Open menu.

Notification Allows you to configure system notifications.
This button provides the same function as
Notification in the menu bar.

Statistics Displays the Statistics window.  Has the same
function as the Statistics command in the Open
menu.
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Troubleshooting
This appendix provides troubleshooting tips for common problems you may en-
counter while using the GUI RAID Manager.  These include the following topics:

¥ Startup errors

¥ Notification errors

¥ SNMP errors

Startup Errors

Error Message1:  Error encountered during OPEN: Unable to Connect to Controller

Cause1:  The GUI RAID Manager was not able to establish a link with the
target disk array system.  This may be caused by one (or more) of the
following:  a wrong baud rate or communication port setting, no disk array
controller is installed, bad RS-232 cable, bad connection, or no null mo-
dem is installed.

Solution1:  Specify the correct baud rate and/or COM port in the Settings of
RS-232 Interface dialog box.  Ensure that the settings you specify corre-
spond to the actual settings on the RS-232 port.  Check also for the re-
quired hardware and cable connection.

Error Message2:  Error encountered during OPEN: Selected Port Not Available

Cause2:  The COM Port you selected does not exist in your system.

Solution2:  Specify the correct COM port in the Settings of RS-232 Interface
dialog box.  Be sure to select the port to which the disk array system is
actually connected.

Error Message3:  Error encountered during OPEN: Selected Port Already in Use

Cause3:  The selected COM port is in use by another program or device.

Solution3:  Select an unused COM port from the Settings of RS-232 Interface
dialog box and connect the controller to this COM port.  Or, locate the
program or device that is using the port and disable or remove it.
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Error Message4:  Error in loading DLL

Cause4:  The GUI RAID Manager cannot find one of its components.

Solution4:  Re-install the GUI RAID Manager.

Notification Errors

Error Condition1:  Pager notification does not work

Cause1:  This error can be caused by one (or more) of the following:  no
modem is connected, the modem is not properly connected to the RS-232
port of the computer, modem is not connected to a telephone line, bad
telephone line, wrong pager number, selected COM port is currently in use
by another program or device, or modem initialization string is not prop-
erly set.

Solution1:  Check the modem, the modem’s RS-232 connection, telephone
line, etc.  Check also if the specified pager number is correct.  If the se-
lected COM port is in use by another program or device, select a different
COM port from the Settings for Modem dialog box.  Or, locate the pro-
gram or device that is using the port and disable or remove it.  Check the
documentation that comes with the modem for information on how to set
properly the modem initialization string.  To check whether or not your
modem settings are correct, use the Test button on the mentioned dialog
box.

Error Condition2:  Some numbers are missing from the message displayed on the
pager

Cause2:  There is not enough delay between the start of dialing and the actual
sending out of the message.

Solution2:  Add commas between the pager number and the message number
in the Personal Information: Pager dialog box.  You may place the commas
at the end of the pager number, or in front of the message number.  If your
pager number is 1234567, for example, and the message you want to send
is 911, you can specify one of the following:

1234567,,, (in the Pager Number text box)

-or-

,,,911 (in the Message text box)
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You can specify as many commas as you want; be reminded though that as
you increase the number of commas, the more delay you are adding be-
tween these processes.  Use the Test button on the mentioned dialog box to
check whether or not the pager notification is functioning properly.

Error Condition3:  Fax notification does not work

Cause3:  This error can be caused by one (or more) of the following:  the
Microsoft Fax Exchange is not properly installed in your system, there is
no modem connected, modem is not properly connected to the RS-232
port of the computer, modem is not connected to a telephone line, bad
telephone line, Fax transmission is not supported by the modem (you should
be using a Fax/modem), wrong Fax number, selected COM port is cur-
rently in use by another program or device, or modem is configured incor-
rectly.

Solution3:  Install the Microsoft Fax Exchange (if not yet installed), check to
verify that the Microsoft Fax Exchange settings are correct, check the sys-
tem modem settings by selecting the Modem Settings option from the Con-
trol Panel, check the connected modem for any connection related errors,
and check the Fax number.  If the selected COM port is currently in use by
another program or device, select another port, or disable or remove the
program (or device).  Use the Test button on the Personal Information: Fax
dialog box to check the Fax notification functionality.

Error Condition4:  E-mail notification does not work

Cause4:  This error can be caused by one (or more) of the following:  the
Microsoft Exchange, Microsoft Mail and/or Microsoft Internet Mail is not
properly installed in your system, there is problem with your Internet con-
nection, E-mail address is not correct, or the recipient’s Mail Server is not
active.

Solution4:  Check the Microsoft Exchange, Mail and Internet Mail settings,
check the Internet connectivity of the local host (specifically the network
interface card and driver programs), and E-mail address.  Use the Test
button on the Personal Information: E-mail dialog box to check the
reachability of the selected destinations.

III. GUI RAID MANAGER
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Error Condition5:  LAN Broadcast notification does not work

Cause5:  This error can be caused by one (or more) of the following:  the
system you are using is not a Windows NT station, the Windows NT Mes-
senger Service is not properly installed, the local host is not properly con-
nected to the network, destination station is not connected to the LAN, or
the computer name is not set.

Solution5:  Check that you have the required software installed in your sys-
tem.  Check also the Internet connectivity of the local host (specifically the
network interface card and driver programs) and the destination comput-
ers, and computer name.  Use the Test button on the Personal Information:
Message dialog box to check the reachability of the selected destinations.

SNMP Errors

Error Message1:  SNMP service not installed

Cause1:  The SNMP service of the local host or the remote manager station is
not installed.

Solution1:  Install the appropriate SNMP service for the environment you are
using for the local host or the remote manager station.  You can get this
service from the software provider; that is, Microsoft for Windows NT and
Windows 95, and Novell for NetWare.

Error Message2:  Failed to open SNMP agent comm

Cause2:  This error can be caused by one (or more) of the following: the
SNMP agent is not reachable over the LAN or WAN, the SNMP service is
not properly installed on the local host and/or the remote manager station,
the GUI RAID Manager’s SNMP agent software is not installed on the
local host, or the disk array controller is not installed or properly con-
nected.

Solution2:  Check the LAN/WAN connections, install the required software
to the local host and/or remote manager station, check the SNMP service
settings, and check that the controller is properly installed and connected.

III. GUI RAID MANAGER
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PART III
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The ASUS PCI-DA2100 RAID controller can be used as a host adapter for SCSI
tape drives and CD-ROM drives. To access such devices under DOS, it is necessary
to install the ASUS PCI-DA2000 Series DOS ASPI Manager device driver.

The ASUS PCI-DA2000 Series DOS ASPI Manager allows DOS/Windows appli-
cations and OS Installation Programs to access CD-ROM drives or SCSI tape drives
that are connected to and properly configured under the ASUS PCI-DA2100 RAID
controller. The ASUS PCI-DA2000 Series ASPI Manager and CD-ROM Driver are
installed as a device driver under DOS by adding the following command lines to
the CONFIG.SYS and AUTOEXEC.BAT files in the root directory of the boot drive
as follows:

In CONFIG.SYS file

DEVICE= [path1]I2DOSASP.SYS

DEVICE = [path1]ASPICDRM.SYS /d:[driver signature]

LASTDRIVE = [logical drive]

In AUTOEXEC.BAT file

[path2]MSCDEX /d:[driver signature]

where:

[path1] – A complete DOS path string including logical drive identifier and
subdirectories indicating where the file I2DOSASP.SYS can be found.

[path2] – A complete DOS path string including logical drive identifier and
subdirectories indicating where the Microsoft CD-ROM extension program,
MSCDEX.EXE, can be found.

[driver signature] – The signature for CD-ROM driver, the driver signature speci-
fied in CONFIG.SYS must match the driver signature specified in AUTOEXEC.BAT
mscdex command.

[logical drive] – The next alphabet of the last logical drive been assigned to hard
disk drives.
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Example:

If there is a subdirectory on the C:\DA2000 containing the ASUS PCI-DA2000 Se-
ries ASPI Manager Manager file I2DOSASP.SYS and CD-ROM Driver file
ASPICDRM.SYS, a subdirectory on the C:\DOS containing the Microsoft CD-ROM
extension program MSCDEX.EXE, and logical drives been assigned to Hard disk
are C: and D:, then the following lines should be added to the CONFIG.SYS and
AUTOEXEC.BAT files respectively:

In CONFIG.SYS file

DEVICE=C:\DA2000\I2DOSASP.SYS

DEVICE = C:\DA2000\ASPICDRM.SYS /D:mscd001

LASTDRIVE = E

In AUTOEXEC.BAT file

C:\DOS\MSCDEX /D:mscd001

Note that there are no restrictions with regard to where these lines are added in the
CONFIG.SYS. Also note that the ASUS PCI-DA2000 Series ASPI Manager will
automatically select an optimal configuration so no load line options are needed.

The ASUS PCI-DA2000 Series ASPI Manager and CD-ROM Driver can be “loaded
high” should it be desirable to conserve system memory space below 640K. Consult
the manual for the particular memory manager installed on your system for details
on how to install a device driver “high”.
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Installing NetWare Drivers

The ASUS PCI-DA2000 Series drivers diskette contains the following driver files
for NetWare v3.1x, v4.0x and v4.1 respectively:

In sub-directory netware\v3_1x:

-ASUSASP.DSK:ASPI manager for NetWare v3.1x
-DA2000.DDI: Installation Information File.
-DA2000.DSK: Disk Driver for NetWare v3.1x

In sub-directory netware\v4_x:

-ASUSASP.DSK:ASPI manager for Netware v4.0x and v4.1
-DA2000.DDI: Installation Information File.
-DA2000.DSK: Disk Driver for NetWare v4.0x and v4.1.

NetWare v3.1x Driver
Follow these procedures to install ASUS PCI-DA2000 drivers for Netware v3.11 or
v3.12.

1 Use ASUS PCI-DA2000 Series BIOS Configuration Utility to disable ISA Mail-
box Emulation mode (default is disabled). To do this, at system bootup, press
[Ctrl-I] , select Configure Card option, then change IO Port Address to DIS-
ABLED.

2 Use ASUS Text RAID Manager to configure Logical Drives and SCSI Devices
and map them to valid SCSI-IDs/LUNs. Note that SCSI ID 7 is reserved for
the ASUS PCI-DA2100 and thus no logical drives or devices should be
mapped to this SCSI ID.

3 Plug one or up to four ASUS PCI-DA2000’s Series into host PCI slots then
power on. ASUS PCI-DA2000 Series BIOS will show the following messages
on the screen for each installed ASUS PCI-DA2000 Series:

ASUS PCI-DA2000 Series (PCI-TO-SCSI RAID) BIOS v1.11
PCI Bus # = 00 Device # = 0A Port = E800 IRQ = 11 EDORAM = 4MB FW=v1.12
!! Press <Ctrl><I> for Configuration Utility, <Q> to Skip !!

4 Make sure the RAID configuration is properly set. (Refer to the section on Text
RAID Manager).
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5 Follow the instructions in the Netware User’s Manual to install the server.

6 Run the NetWare v3.11 or v3.12 SERVER.EXE program to star the server.

7 At the system console prompt, use load command to load the ASUS PCI-DA2000
Series driver by typing load DA2000.DSK[Enter]

8 System console will display the following messages on the screen:

Loading module DA2000.DSK
ASUS PCI-DA2000 Disk Driver for NetWare v3.1x
Version 1.11c November 3, 1995
Auto-loading module ASUSASPI.DSK
ASUS ASPI Manager for NetWare v3.1x, v4.0x and v4.1
Version 1.11b October 27, 1995

Supported Slot values are 11
Slot: 11

The slot number (value) is auto-detected by ASUS PCI-DA2000 Series driver
according to which PCI slot the ASUS PCI-DA2000 Series been plugged into.
Write down the slot number for later using in STARTUP.NCF.

9 At this point, press [Enter]. If ASUS PCI-DA2000 Series driver installs suc-
cessfully, the system console will display the following messages on the screen:

PCI Bus # = 0, Device # = 9, Port = E400, IRQ = 10
ASUS Disk Driver Installed Successfully

10 Load the driver “DA2000.DSK” once for each installed ASUS PCI-DA2000.
This driver supports up to four ASUS PCI-DA2000 Series Controller.

11 After each instance of the ASUS PCI-DA2000 Series driver has been loaded
successfully, continue with the operations of Novell NetWare server described
in NetWare User’s Manual.

Notes:
The correct syntax in STARTUP.NCF file to load the ASUS PCI-DA2000 Series
drivers is similar to the following:

# load DA2000 slot = x

x is the slot number of slot into which the ASUS PCI-DA2000 Series been plugged.
The slot number is auto-detected by ASUS PCI-DA2000 Series driver and shown
on the system console screen during ASUS PCI-DA2000 Series driver loading.
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NetWare V4.0x/v4.1 Driver
1 Use ASUS PCI-DA2000 Series BIOS Configuration Utility to disable ISA Mail-

box Emulation mode(default is disabled). To do this, at system bootup, press
[Ctrl-I] , select Configure Card option, then change IO Port Address to DIS-
ABLED.

2 Use ASUS RAID Manager or RS-232 Terminal Interface Operation to config-
ure Logical Drives and SCSI Devices and map them to valid SCSI-IDs/LUNs.
Note that SCSI ID 7 is reserved for the ASUS PCI-DA2000 Series adapter
and thus no logical drives or devices should be mapped to this SCSI ID.

3 For installation of a new server, follow these procedures:

4 If your Netware installation package is a CD-ROM version and the CD-ROM
Drive used to perform the installation is connected to an ASUS PCI-DA2000
Series, make sure the ASUS PCI-DA2000 Series ASPI manager
“I2DOSASP.SYS”, CD-ROM driver “ASPICDRM.SYS”, and Microsoft CD-
ROM extension program “MSCDEX.EXE” are specified in DOS files
CONFIG.SYS and AUTOEXEC.BAT.

5 Plug up to four ASUS PCI-DA2000 Series into host PCI slots then power on.
ASUS PCI-DA2000 Series BIOS will show the following messages on the screen
for each installed ASUS PCI-DA2000 Series:

ASUS PCI-DA2000 Series (PCI-TO-SCSI RAID) BIOS v1.11
PCI Bus # = 00 Device # = 0A Port = E800 IRQ = 11 EDORAM = 4MB FW=v1.12
!! Press <Ctrl><I> for Configuration Utility, <Q> to Skip !!

6 Make sure the RAID configuration is properly set. (Refer to section 4 Text RAID
Manager and RS-232 Terminal Interface Operation).

7 Change to sub-directory where the Netware install program locate, then typing
install and press Enter.

Example:
Assume the CD-ROM is mapped to DOS logical drive D, type the following
at the DOS prompt:

CD D:\NETWARE.40\ENGLISH

install
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Loaded Drivers

NetWare Server Installation v4.x  NetWare loadable Module

Load Disk Driver

Choose a disk driver that corresponding to the disk controller
hardware in this server. Repeat this step for additional drivers.

ISADISK.DSK Novell ISADISK (AT Compatible) Driver
MNS16S.DSK Mountain Network Solutions, Inc - SCSI Controller Driver
MNS8MM.DSK Mountain Network Solutions, Inc - SCSI 8MM Device Driver
MNSDAT.DSK Mountain Network Solutions, Inc - SCSI DDS DAT Device Driver
PM11NW40.DSK DPT ISA SCSI HBA Driver

Use this driver with ESDI, MFM, and ST-506 drives
that have adapter boards using the standard AT disk
interface. The ISADISK driver can use controllers at
both the primary and the secondary addresses. This
allows two adapter cards to be installed in the host

Load a disk driver listed <Enter>
Load a disk driver not listed <Ins>
Unload a disk driver <Del>
Scroll help windows <F5>(up) <F6>(dn) Change lists <F2>
Help<F1> Continue <F10> Abort INSTALL <Alt><F10>

8 Follow the instructions in the Netware User’s Manual until following screen appears:

NetWare Server Installation v4.x NetWare loadable Module

Path A:\ will be scanned for drivers to install. Verify that this
directory path corresponds to where the driver file (*.DSK, *.CMD, *.HAM,
or *.VDM) is located. Drives for a large number of disk controllers are
included with NetWare. You may insert the appropriate NetWare diskette
(or specify a NetWare CD-ROM directory), or insert a third-party diskette.

Disk drivers are in the directory \NETWARE.40\________\DISKDRV and LAN
drivers are in \NETWARE.40\________\LANDRV on the CD-ROM.

Press <F3> to specify a different path;
Press <Enter> to continue.

Continue <Enter>
Specify a different source drive/directory <F3>
Help <F1> Previous screen <Esc> Abort INSTALL <ALT><F10>

9 Press [Ins] then wait for the following screen to appears:
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10 Press [F3] then wait for the following screen to appears:

Continue <Enter>
Specify a different source drive/directory <F3>
Help <F1> Previous screen <Esc> Abort INSTALL <ALT><F10>

NetWare Server Installation v4.x NetWare loadable Module

Specify a directory path:

>A:\

11 Insert the ASUS PCI-DA2000 Series Driver Diskette into floppy A: and type
netware\v4.x and press [Enter] then wait for the following screen to appears:

Loaded Drivers

NetWare Server Installation v4.x NetWare loadable Module

Select a new disk driver to install:

DA2000.DSK  ASUS PCI-DA2000 Series PCI-TO-SCSI Disk Driver for NetWare v4.0x, v4.1

ASUSASPI.DSK  ASUS ASPI Manager for Netware v3.1X, v4.0x and v4.1

This driver supports up to four ASUS PCI-DA2000 Series and multiple
SCSI LUN.
When you load DA2000.DSK you have to specify which ASUS PCI-DA2000
Series you are loading the driver for by using the command line option
‘SLOT=N’.

Select multiple disk drivers <F5>
Load a driver listed <Enter>
Unload a driver <Del>
Scroll help windows <F7>(up) <F8>(dn) Change lists <F2>
Help <F1> Previous screen <Esc> Abort INSTALL <Alt><F10>
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12 Select DA2100.DSK as a new disk driver to install by pressing ≠ key and press-
ing [Enter] then wait for the following screen to appears:

NetWare Server Installation v4.x NetWare loadable Module

loading driver DA2000.DSK ...

Please wait

13 Press [ALT] [ESC] keys at the same time to switch to system console screen or
wait for the NetWare installation program to time out. When it times out, the
following screen will appear:

NetWare Server Installation v4.x NetWare loadable Module

DA2000.DSK did not finish loading in the time allowed (15 seconds).
Controller will be switched to the system console screen, where you may either see it
finish or enter information to finish loading it. (INSTALL-4.0-247)

Press <Enter> to continue.
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14 Press [Enter] to switch to system console screen.

 LOAD C:\SERVER.40\DA2000.DSK
 ASUS PCI-DA2000 Series Disk Driver for NetWare v4.0x, v4.1
 Version 1.11b October 27, 1995
 Auto-loading module ASUSASPI.DSK
 ASUS ASPI Manager for NetWare v3.1x, v4.0x and v4.1
 Version 1.11b October 27, 1995
 Supported Slot values are 11
 Slot: 11

The slot number (value) is auto-detected by ASUS PCI-DA2000 Series driver ac-
cording to which PCI slot the ASUS PCI-DA2000 Series been plugged into. Write
down the slot number for later using in STARTUP.NCF.

15 Press [Enter] on system console screen

Driver DA2000 was successfully loaded.

Press <Enter> to continue

NetWare Server Installation v4.x NetWare loadable Module
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17 Select “Continue with installation” and press [Enter] to continue the installation.

Note:
The correct syntax in STARTUP.NCF file to load the ASUS PCI-DA2000 Series
drivers is similar to the following:

# load DA2000 slot = x

x is the slot number of slot into which where the ASUS PCI-DA2000 Series been
plugged. The slot number is auto-detected by ASUS PCI-DA2000 Series driver
and shown on the system console screen during ASUS PCI-DA2000 Series driver
loading.

16 Press [Enter] to continue the installation

NetWare Server Installation v4.x NetWare loadable Module

Select an action:

Load driver DA2000 again
Load another (different) driver
Continue with installation
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Installing Windows NT Drivers

Up to 4 ASUS PCI-DA2000 Series adapters can be installed in one computer. The
following files are supplied for driver installation, to be found in the subdirectory
\WINNT\V3_1 for Windows NT 3.1.

-DA2000.SYS: PCI-DA2000 Series Miniport Driver for Windows NT 3.1
-PCIDA: PCI Disk Array Tag File
-OEMSETUP.INF: Information file for driver installation
-TXTSETUP.OEM: Information file for driver installation
The following files are supplied for driver installation, they are put in the
\WINNT\V3_5X subdirectory for Windows NT 3.5X.

-DA2000.SYS: PCI-DA2000 Series Miniport Driver for Windows NT 3.5x
-PCIDA: PCI Disk Array Tag File
-OEMSETUP.INF: Information file for driver installation
-TXTSETUP.OEM: Information file for driver installation

Windows NT Not Installed or to be Upgraded
Follow these steps only if Windows NT is not installed on your computer or if you
are upgrading to a new version of Windows NT.

1 Use ASUS PCI-DA2000 Series BIOS Configuration Utility to disable ISA Mail-
box Emulation mode (default is disabled). To do this, at system bootup, press
[Ctrl-I] , select Configure Card option, then change IO Port Address to DIS-
ABLED.

2 Use ASUS Text RAID Manager to configure Logical Drives and SCSI Devices
and map them to valid SCSI-IDs/LUNs. Note that SCSI ID 7 is reserved for
the ASUS PCI-DA2000 Series adapter and thus no logical drives or devices
should be mapped to this SCSI ID.

3 Prepare for the installation by using DISKCOPY (or any other diskcopy utility)
to make backup copy of ASUS PCI-DA2000 Series distribution diskette. If you
are installing Windows NT 3.1, copy all files from \WINNT\V3_1 to root direc-
tory of the backup diskette. If you are installing Windows NT 3.5x, copy all files
from \WINNT\V3_5X to root directory of the backup diskette. Use the backup
copy as your working diskette.
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4 If you are installing Windows NT from a floppy drive, insert the “Windows NT
Disk #1” into floppy drive A. If you are installing Windows NT from a CD-
ROM drive, insert the “Windows NT Setup Boot Disk” into floppy drive A.

5 Power on your computer.

6 When Prompted, select Custom Setup. If you are installing Windows NT 3.1 go
to step 8.

7 Press S to skip mass storage devices detection.

8 Windows NT setup cannot find any adapter and displays NONE. Press S to
specify additional SCSI adapters. From the list of SCSI adapters, select “Other
(Requires disk provided by a hardware manufacturer)”.

9 Insert ASUS PCI-DA2000 Series Distribution Diskette into floppy drive A and
press [Enter]. The screen displays “ASUS PCI-DA2000 Series PCI-TO-SCSI
RAID Miniport”. Then, press [Enter] to select this driver.

10 Press [Enter] to continue Windows NT setup and follow the steps given in Win-
dows NT Installation documentation.

Existing Windows NT System
If you are adding an ASUS PCI-DA2000 Series adapter to a computer that already
has an ASUS PCI-DA2000 Series adapter installed for Windows NT, then follow
step 1 through step 2 only.

If you are adding an ASUS PCI-DA2000 Series adapter to a computer that has no
ASUS PCI-DA2000 Series adapter installed for Windows NT, then follow all steps.

1 Use ASUS PCI-DA2000 Series BIOS Configuration Utility to disable ISA Mail-
box Emulation mode (default is disabled). To do this, at system bootup, press
[Ctrl-I] , select Configure Card option, then change IO Port Address to DIS-
ABLED.

2 Use ASUS Text RAID Manager or RS-232 Terminal Interface Operation to con-
figure Logical Drives and SCSI Devices and map them to valid host SCSI-IDs/
LUNs. Note that SCSI ID 7 is reserved for the ASUS PCI-DA2000 Series
adapter and thus no logical drives or devices should be mapped to this SCSI
ID .
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3 Prepare for the installation by using DISKCOPY (or any other disk-copy utility)
to make backup copy of ASUS PCI-DA2000 Series distribution diskette. If you
are installing Windows NT 3.1, copy all files from \WINNT\V3_1 to root direc-
tory of the backup diskette. If you are installing Windows NT 3.5x, copy all files
from \WINNT\V3_5X to root directory of the backup diskette. Use the backup
copy as your working diskette.

4 Boot Windows NT. Select the “Windows NT Setup” program from the “Main”
program group.

5 Select the “Options” pull-down menu and then select “Add/Remove SCSI Adapt-
ers”. The “SCSI Adapter Setup” displays a list of installed SCSI Adapters. Then
select “Add” to add an ASUS PCI-DA2000 Series adapter to the list.

6 Select “OK” to make sure you want to add a SCSI adapter, “Windows NT Setup”
displays “Select SCSI Adapter Option” and a list of SCSI adapters. Expand the
list of SCSI adapters, select “Other (Requires disk provided by a hardware manu-
facturer)” .

7 Insert ASUS PCI-DA2000 Series Distribution Diskette into floppy drive A and
press [Enter]. The screen displays “ASUS PCI-DA2000 Series PCI-TO-SCSI
RAID Miniport”. Then, select “OK” to select this driver, then select “Install” .

8 Enter the path, normally it is A:\, to the directory with the device driver, then
select “Continue”. “Windows NT Setup” copies device driver to your disk and
updates configuration to make new configuration take effect after system reboots.

9 Make sure the new added device driver is in the installed SCSI adapter list, then
press “Close” to exit the “SCSI Adapter Setup”, and then close the “Windows
NT Setup” program. If you are not running Windows NT 3.1, go to step 11, or do
step 10.

10 Select “Control Panel” program from “Main” program group. Select “Devices”
program. A device list appears, select the ASUS PCI-DA2000 Series device,
then click on the “Startup” button. Change Startup type to “System”, then select
“OK”. Select “Close” to exit “Devices” program, then close the “Control Panel”
program.

11 Shutdown Windows NT, then restart your computer. It is possible that some
drive letter assignments may be different from previous configuration.

III. WINDOWS NT
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Updating Windows NT Device Driver
1 Copy the new device driver from the distribution diskette to the directory

[SystemRoot]\system32\drivers, where [SystemRoot] is the system root direc-
tory of Windows NT.

For example, if the system root directory is C:\WINNT, then type the following:

 copy a:\winnt\v3_1\DA2000.SYS c:\winnt\system32\drivers

Skip step 2 if the version of your Windows NT is not v3.1.

2 If one of the ASUS PCI-DA2000 Series adapters control the system boot disk,
use ATTRIB.EXE to disable the hidden, system and read only attributes of
c:\ntbootdd.sys, then copy the same driver to c:\ntbootdd.sys and restore the
attributes of c:\ntbootdd.sys.

For example,

attrib -h -r -s c:\ntbootdd.sys

copy a:\winnt\v3_1\DA2000.SYS c:\ntbootdd.sys

attrib +h +r +s c:\ntbootdd.sys

3 Shutdown Windows NT, then restart your computer.
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IV. WINDOWS 95

Installing Windows 95 Driver

 The following files are supplied for driver installation, they are put in the \WIN95
subdirectory for Windows 95.

-DA2000.MPD: ASUS PCI-DA2000 Series family Miniport Driver for Windows
95.

-DAW95.INF : Information file for driver installation.

Installing Windows 95 and the Driver
1 Use ASUS PCI-DA2000 Series BIOS Configuration Utility to disable ISA Mail-

box Emulation Mode (default is disabled). To do this, at system bootup, press
[Ctrl-I], select Configure Card option, then change IO Port Address to DIS-
ABLED.

2 Use ASUS Text RAID Manager to configure Logical Drives and SCSI Devices
and map them to valid SCSI-IDs/LUNs.

Note that SCSI ID 7 is reserved for the ASUS PCI-DA2101 RAID controller
and thus no logical drives or devices should be mapped to this SCSI ID.

3 Follow the instructions in Windows 95 installation documentation to install
Windows 95.

4 When Windows 95 installation is complete, restart Windows 95.

5 Click on the “Start” button on the task bar of Windows 95.

6 Select “Settings”, and then click on “Control Panel”.

7 Double-click on the “System” icon, then click on “Device Manager” tab.

8 Click on the plus sign next to the “Other devices” icon, then Double-click on the
yellow question mark labelled “PCI SCSI Bus Controller” icon, then click on
the “Driver” tab.

9 In the Driver tab, click on “Change Driver”. When asked to select hardware
type, select “SCSI Controllers”.
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10 Click on the “Have Disk” button and enter a:\win95 as the subdirectory to copy

the manufacturer’s file from. Insert ASUS PCI-DA2000 Series distribution dis-
kette into drive A: and click on “OK”.

11 Select “ASUS DA-2000 Series PCI-to-SCSI RAID Adapter”, and click on “OK”.

12 Click on “OK”. The driver is copied.

13 When asked to remove ROM BIOS of ASUS PCI-DA2000 Series Controller,
you MUST click on “Cancel” to keep ROM BIOS.

14 You must restart your system for the changes to take effect. Click on “Yes” to
shutdown the system and restart your computer.

15 When the system is booting up, an “Unknown Device” warning window will be
displayed, this is a normal behavior because a virtual target is registered by
ASUS PCI-DA2000 Series family Miniport Driver to support ASUS GUI RAID
Manager. Please select “Do not install a driver” , and click on “OK”.

16 Make sure that the ASUS PCI-DA2000 Series family Miniport Driver is work-
ing properly by using Device Manager tab of System icon in Control Panel.
Click on the plus sign next to the SCSI controllers icon, and double-click on the
Infortrend ASUS PCI-DA2000 Series PCI-to-SCSI RAID Adapter icon. Check
the Device status. If the device is working properly, the driver is installed suc-
cessfully. If not, the driver is not installed. Check your CONFIG.SYS to see if
I2DOSASP.SYS is installed. If it is installed, remove it, and restart your com-
puter.
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Updating the Driver
1 Click on the “Start” button in the task bar of Windows 95.

2 Select “Settings”, and then click on “Control Panel”.

3 Double-click on the “System” icon, then click on “Device Manager” tab.

4 Click on the plus sign next to the “SCSI controller” icon, then Double-click on
the “ASUS PCI-DA2000 Series PCI-to-SCSI RAID Adapter” icon. Click on the
“Driver” tab.

5 On the “Driver” tab, click on “Change Driver”.

6 Click on the “Have Disk” button and enter a:\win95 as the subdirectory to copy
the manufacturer’s file from. Click “OK”.

7 Select ASUS PCI-DA2000 Series PCI-to-SCSI RAID Adapter, and click on
“OK”.

8 Click on “OK”. The driver is copied.

9 You must restart your system for the changes to take effect. Click on “Yes” to
shutdown the system and restart your computer.

IV. WINDOWS 95
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Installing the OS/2 Driver

Up to 4 ASUS PCI-DA2000 Series controllers can be installed in one computer.
The following files are supplied for driver installation, they are put in the \OS2
subdirectory.

DA2000.ADD:
ASUS PCI-DA2000 Series OS/2 2.x and 3.0 (Warp) Device Driver.

DA2000.DDP:
Device Driver Profile for driver installation.

README.OS2:
An text file describing the ASUS PCI-DA2000 Series OS/2 driver.

NOTE:  The RS-232 Terminal Interface Operation requires an RS-232 port.
Thus this interface cannot be used on the ASUS PCI-DA2100, which does not
have an RS-232 port on board.

Installing OS/2 2.x or 3.0
Follow these steps only if OS/2 2.x, 3.0 is not installed on your computer or if you
are upgrading to OS/2 2.x or 3.0.

1 Use ASUS PCI-DA2000 Series BIOS Configuration Utility to disable ISA Mail-
box Emulation mode (default is disabled). To do this, at system bootup, press
[Ctrl-I] , select Configure Card option, then change IO Port Address to DISABLED.

2 Use ASUS Text RAID Manager or RS-232 Terminal Interface Operation to
configure Logical Drives and SCSI Devices and map them to valid SCSI-IDs/
LUNs. Note that SCSI ID 7 is reserved for the ASUS PCI-DA2000 Series
adapter and thus no logical drives or devices should be mapped to this
SCSI ID.

3 Prepare for the installation by using DISKCOPY (or any other disk-copy util-
ity) to make backup copy of IBM OS/2 installation diskette #1. Use this copy as
your working diskette #1.

4 Copy DA2000.ADD from ASUS PCI-DA2000 Series Distribution Diskette to
OS/2 installation diskette #1. Modify the CONFIG.SYS file on OS/2 installa-
tion diskette #1 to add the following line to the end of CONFIG.SYS:

BASEDEV=DA2000.ADD /V

5 Follow the steps from IBM for installing OS/2.

V. OS/2
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V. OS/2

Installing in an Existing OS/2 2.x/3.0
If you are adding an ASUS PCI-DA2000 Series controller to a computer that al-
ready has an ASUS PCI-DA2000 Series controller installed for OS/2 2.x/3.0, then
follow step 1 through step 2 only. If you are adding an ASUS PCI-DA2000 Series
controller to a computer that has no ASUS PCI-DA2000 Series controller installed
for OS/2 2.x/3.0, then follow all steps.

1 Use ASUS PCI-DA2000 Series BIOS Configuration Utility to disable ISA Mail-
box Emulation mode (default is disabled). To do this, at system bootup, press
[Ctrl-I] , select Configure Card option, then change IO Port Address to DIS-
ABLED.

2 Use ASUS Text RAID Manager or RS-232 Terminal Interface Operation to con-
figure Logical Drives and SCSI Devices and map them to valid SCSI-IDs/LUNs.
Note that SCSI ID 7 is reserved for the ASUS PCI-DA2000 Series controller
and thus no logical drives or devices should be mapped to this SCSI ID.

3 Execute the program DDINSTAL by selecting the Device Driver Install icon
within the System Setup folder of OS/2 System folder or by typing DDINSTAL
at OS/2 prompt.

4 Insert the ASUS PCI-DA2000 Series Distribution Diskette in the appropriate
floppy drive and follow the instructions from DDINSTALL. Set the source di-
rectory to a:\os2 and the destination path to the root directory of system drive
while running DDINSTALL.

5 Reboot your system.

Updating the Driver
1 Copy the new device driver from the distribution diskette to the root directory of

system drive where that OS/2 is installed.

For example,

copy a:\os2\DA2000.ADDc:\

2 Shutdown OS/2, then restart your computer.
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V. OS/2

OS/2 Driver Command-Line Options
1 Driver Command Syntax :

BASEDEV=DA2000.ADD [Driver-Options][Adapter-Options][Unit-Options]

The command and options must be put in the CONFIG.SYS file. The changes of
command-line option will not take effect until the system is restarted.

2 Command-Line Options :
1) Command-line options are case-insensitive.

2) All command-line options begin with the slash character (/).

3) The exclamation character (!) is a negation operator; that is, it negates the
option that follows it.

3 Driver-Options :
/V
Verbose. Either Display the driver name, version number, date, adapter Information
and device information if the driver loads successfully, or display error messages if
the driver fails to initialize.

/(!)ET
(Disable) Enable Embedded Target Support. Makes the driver (disable) enable not-
zero SCSI LUN support. Default setting is /ET.

/PCI:n
Maximum PCI Bus Number in the computer. Where n is a decimal value between 0
to 255. Default value is 255.
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V. OS/2
4 Adapter-Options :
/A:n
Adapter Identification. Where n is a decimal value. This option specifies the order-
ing of adapters. Normally, adapters are numbered consecutively, starting at 0.

/BUS:n
PCI Bus Number which ASUS PCI-DA2000 Series is plugged in. You can get the
PCI bus number from the information that ASUS PCI-DA2000 Series BIOS dis-
plays at system bootup.

Note: ASUS PCI-DA2000 Series BIOS displays bus number in hex value, you
must translate that into decimal value.

/DEV:n
PCI Device Number which ASUS PCI-DA2000 Series is plugged in. You can get
the PCI device number from the information that ASUS PCI-DA2000 Series BIOS
displays at system bootup.

Note: ASUS PCI-DA2000 Series BIOS displays device number in hex value,
you must translate that into decimal value.

/(!)ET
(Disable) Enable Embedded Target Support. Makes the driver (disable) enable not-
zero SCSI LUN support to the specified adapter by /A:n . Default setting is /ET.

/(!)DM
(Disable) Enable Direct Access Storage Device (DASD) Manager Support. (Dis-
able) Enable all the units, connect to the adapter specified by /A:n, to be supported
by the IBM-supplied DASD manager (OS2DASD.DMD). The default setting is /
DM.

/(!)SM
(Disable) Enable SCSI Manager Support. (Disable) Enable all the units, connect to
the adapter specified by /A:n, to be supported by the IBM-supplied SCSI manager
(OS2SCSI.DMD). The default setting is /SM.

5 Unit-Options :
/(!)ET:i1,i2,i3....
(Disable) Enable Embedded Target Support. Where i1,i2,i3 is the specified SCSI
Target ID. Makes the driver (disable) enable not-zero SCSI LUN support to the
specified SCSI ID of the specified adapter by /A:n. Default setting is /ET.
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V. OS/2
/(!)DM:i1,i2,i3... OR /(!)DM:(i1,l1),(i2,l2)....
(Disable) Enable Direct Access Storage Device (DASD) Manager Support. Where
i1,i2,i3 is the specified SCSI Target ID. (i1,l1),(i2,l2) is the specified SCSI Target
ID-LUN. (Disable) Enable the specified SCSI Target ID(LUN) of the adapter speci-
fied by /A:n, to be supported by the IBM-supplied DASD manager
(OS2DASD.DMD). The default setting is /DM. The boot device MUST be sup-
ported by DASD Manager, or the computer can not be able to boot OS/2.

/(!)SM:i1,i2,i3... OR /(!)SM:(i1,l1),(i2,l2)....
(Disable) Enable SCSI Manager Support. Where i1,i2,i3 is the specified SCSI Tar-
get ID. (i1,l1),(i2,l2) is the specified SCSI Target ID-LUN. (Disable) Enable the
specified SCSI Target ID(LUN) of the adapter specified by /A:n, to be supported by
the IBM-supplied SCSI manager (OS2SCSI.DMD). The default setting is /SM.

NOTE:  The driver will find all the ASUS PCI-DA2000 Series controller in
your computer automatically, if no /BUS and /DEV options specified.
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VI. SCO UNIX
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The chapter describes how to install SCO UNIX BTLD (Boot Time Loadable Driver)
for ASUS PCI-DA2000 Series Controller.

NOTE:  The RS-232 Terminal Interface Operation requires an RS-232 port. Thus
this interface cannot be used on the ASUS PCI-DA2100, which does not have
an RS-232 port on board.

Installing SCO UNIX
1 Use ASUS PCI-DA2000 Series BIOS Configuration Utility to disable ISA Mail-

box Emulation mode (default is disabled). To do this, at system bootup, press
[Ctrl-I] , select Configure Card option, then change IO Port Address to DIS-
ABLED.

2 Use ASUS Text RAID Manager or RS-232 Terminal Interface Operation to con-
figure Logical Drives and SCSI Devices and map them to valid SCSI-IDs/LUNs.
Note that SCSI ID 7 is reserved for the ASUS PCI-DA2000 Series controller
and thus no logical drives or devices should be mapped to this SCSI ID.

3 Check IO devices, CD-ROM or TAPE drive is properly installed.

4 Insert the N1 boot diskette into the floppy drive and turn on the PC. When the
“boot” message appears, type link  as follows:

SCO UNIX System V/386

Boot: link <Enter>

5 Type PCIDA  at the following prompt:

What packages do you need linked in the system,

or ‘q’ to quit?: pcida
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VI. SCO UNIX
6 You will be prompted to insert the DA2000 Series BTLD diskette after a series

of messages as follows:

Please insert the fd(x)pcida volume and press <RETURN>

or ‘q’ to quit:

7 After Insert the diskette, press [Enter].

Follow the appropriate SCSI manual to install the SCO UNIX from the installa-
tion media (floppy, tape, or CD-ROM).

8 A message similar to the following will be displayed:

Please insert the pcida volume and press <ENTER>:

Insert the ASUS BTLD diskette again and press [ENTER]

9 At the following prompt, type “y”:

The BTLD packages will now be added to the Link Kit.

The Link Kit is not installed.

Do you wish to install it now?(y/n)

VI. SCO
 UNIX
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VI. SCO UNIX
10 At the following prompt, press [ENTER] :

The following packages are on this diskette:

NAME DESCRIPTION

pcida ASUS PCI-DA2000 Series SCSI Disk Array Driver for

SCO UNIX system

Please enter the names of the packages you

wish to install or q to quit:_

[default:pcida]

11 The ASUS PCI-DA2000 Series driver will now be linked into the SCO UNIX
kernel.
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